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Introduction
QuickPHOTO Industrial 2.3 is intended for capturing images especially from microscopes
equipped with digital cameras, for editing digital images and measurements. Live image
from a microscope displayed on a PC screen simplifies focusing and correct exposition of
images. The program is especially designed for use industry and material science. 1

QuickPHOTO Industrial 2.3 features many measuring functions, such as inserting of
calibred scale bar, measurement of lengths, perimeters, areas, angles, arcs, distances of
parallel lines, objects counting, phase analysis and hardness measurement. By using the
time lapse imaging module, images can be captured in a predefined time interval. The
software can also be installed on notebooks and used in the field.

Warning

The software is not intended for diagnosing and determining medical
procedures.

1 An updated list of supported photographic equipment is available at www.promicra.com.
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Installation
Important

Installation should be made from the administrator account (the user logged in
should have administrative privileges). If you are not a holder of the administrator
account, please contact your PC supervisor.

Important

If you use Microsoft® Windows® 2000 operating system, Update Rollup 1 for
Windows 2000 SP4 (KB891861) must be installed before installing the
QuickPHOTO Industrial 2.3 program. You can use either Windows® Update
service or download it from www.microsoft.com.

To install the program QuickPHOTO Industrial 2.3 follow these steps:

1. Installation of an imaging device (digital cameras, consumer digital cameras,
other imaging devices)

Depending on the type of used imaging device select one of the following steps:

▪ OLYMPUS® consumer digital camera (E-System, CAMEDIA® and SP series)

Installation consists of two steps:

a. Installation of a device for displaying a live image see “Installation of a Device
for Displaying a Live Image“ on page 10.

b. Installation of OLYMPUS® consumer digital camera (E-System, SP and
CAMEDIA® series) see “Installation of OLYMPUS® Consumer Digital Camera
(E-System, SP and CAMEDIA® series)“ on page 17.

▪ Digital cameras and other imaging devices

Follow the instructions in relevant chapters e.g. for IDS uEye® camera see “IDS
uEye® Digital Camera Installation“ on page 22.
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The rest of installation steps except for the Completing the installation are common
for all types of imaging devices.

2. Installation of a dongle

3. Installation of the application

4. Completing the installation

1. Installation of a Device for Displaying a Live
Image

QuickPHOTO Industrial 2.3 used with an OLYMPUS® digital camera is supplied with
one of the following devices for displaying a live image:

1. Internal PCI card Leadtek WinFast VC100 XP
2. External USB 2.0 device AV USB 2.0 PRO
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Important

For correct display of a live image, 24 or 32bit colour depth should be set in
Microsoft® Windows®. Set the colour depth as follows:

• Microsoft® Windows® Vista

1. Close all applications and right mouse click on the desktop. In the menu
displayed, choose Personalize.

2. Select the Display Settings option from the opened window.
3. From the Colours drop-down menu select High (24 bit) or Highest (32 bit).

(32 bit is recommended if available).
4. Press the OK button.

• Microsoft® Windows® XP

1. Close all applications and right mouse click on the desktop. In the menu
displayed, select Properties.

2. In the Display Properties dialog select the Settings tab.
3. From the Colour quality drop-down menu select High (24 bit) or Highest
(32 bit). (32 bit is recommended if available).

4. Press the OK button.

Installation of DirectX

To operate the device for displaying a live image, installation of the DirectX 9.0c software
interface or higher is required. You can find out the currently installed version as follows:

1. Press the Start button and select Run... option.
2. In the displayed dialog, type “dxdiag”. In the newly opened window, you can see the

currently installed version of DirectX (e.g. DirectX 8.0) in the lower part of the dialog.

If you have any older version of DirectX in your computer, install the new one from the
installation CD of QuickPHOTO Industrial 2.3 from the directx folder.
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Note

Microsoft® Windows® Vista operating system contains DirectX 10 by default,
Microsoft® Windows® 7 contains the DirectX 11.

1.1. Installation of Leadtek WinFast VC100 XP Internal
PCI Device

Important

In case you are installing the Leadtek WinFast VC100 XP card in a computer in
which there is or was the ATI TV Wonder card installed (previously delivered
with QuickPHOTO products), the ATI card should be removed first and the
Leadtek card installed into a different PCI slot. Otherwise, your computer should
not work properly.

1. Turn your computer off and disconnect it from the mains.
2. Install the card in a free PCI slot (as far from other cards as possible) and tighten it

by the screw.
3. Connect the mains and turn your computer on.

Installation of Leadtek WinFast VC100 XP device drivers in Microsoft®

Windows® Vista

1. After turning your computer on, Found New Hardware Wizard appears. To install
the device drivers, insert the installation CD of QuickPHOTO Industrial 2.3 and click
on Locate and install driver software (recommended) option.

2. When the User account control window appears press the Continue button.
3. When the Found New Hardware - Unknown device window appears, click on the

Browse my computer for driver software (advanced) option.
4. In the next dialog, you will be required to specify the location of the drivers. Press

the Browse button and locate Drivers\Leadtek WinFast VC100 XP folder on the
installation CD. Continue with Next button.

5. Complete the installation of the device driver by pressing the Close button. Correctly
installed drivers will display in the Device manager (see figure below).
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Installation of Leadtek WinFast VC100 XP device drivers in Microsoft®

Windows® XP

1. After turning your computer on, Found New Hardware Wizard appears. To install
the device drivers, insert the installation CD of QuickPHOTO Industrial 2.3 and press
the Next button.

2. In the displayed dialog select Install the software automatically (Recommended) and
press the Next button.

3. A warning that the driver has not passed Windows Logo testing appears. Press the
Continue anyway button.

4. Complete the installation of the driver by pressing the Finish button. Repeat the
procedure for all three drivers. Correctly installed drivers will display in the Device
manager (see figure below). If only two drivers are installed (WinFast VC100 WDM
Crossbar driver is missing), it is necessary to install the Leadtek WinFast VC100 XP
card in another PCI slot and repeat the procedure for installing the drivers.

If, during the installation, you are required to locate the CsMini20.sys file, press the Browse
button and locate the file on the installation CD of QuickPHOTO Industrial 2.3 in the
Drivers\Leadtek WinFast VC100 XP folder. Continue by pressing the OK button.
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Installation of Leadtek WinFast VC100 XP device drivers in Microsoft®

Windows® 2000

Note

If you use Microsoft® Windows® 2000, Service Pack 4 must be installed before
installing the drivers. You can use either Windows® Update service or download
it from www.microsoft.com.

1. After turning your computer on, Found New Hardware Wizard appears. To install
the device drivers, insert the installation CD of QuickPHOTO Industrial 2.3 and press
the Next button.

2. In the displayed dialog select Install the software automatically (Recommended) and
press the Next button.

3. In the next dialog, you will be required to specify the location of the drivers. Choose
Select other location option and press the Browse button. Locate Drivers\Leadtek
WinFast VC100 XP folder on the installation CD. Press the OK. Continue with the
Next button.

4. Complete the installation of the driver by pressing the Finish button. Repeat the
procedure for all three drivers. Correctly installed drivers will display in the Device
manager (see figure below). If only two drivers are installed (WinFast VC100 WDM
Crossbar driver is missing), it is necessary to install the Leadtek WinFast VC100 XP
card in another PCI slot and repeat the procedure for installing the drivers.

If, during the installation, you are required to locate the CsMini20.sys file, press the Browse
button and locate the file on the installation CD of QuickPHOTO Industrial 2.3 in the
Drivers\Leadtek WinFast VC100 XP folder. Continue by pressing the OK button.
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1.2. Installation of AV USB 2.0 PRO External Device

Note

The AV USB 2.0 PRO device is equipped with following connectors:

• yellow CINCH connector for connection of analog video signal source
• red CINCH connector for connection of right channel of audio signal
• white CINCH connector for connection of left channel of audio signal
• black S-Video connector for connection of S-Video video signal source

Connect the USB cable of AV USB 2.0 PRO device to the USB 2.0 port of your running
computer.

Installation of AV USB 2.0 PRO device drivers in Microsoft® Windows®

Vista

1. After connecting the AVUSB 2.0 PRO device to your computer,Found NewHardware
Wizard appears. To install the device driver, insert the installation CD of QuickPHOTO
Industrial 2.3 and click on Locate and install driver software (recommended) option.

2. When the User account control window appears press the Continue button.
3. Wait for an automatic installation of the driver. It can take a few minutes.
4. Press the Close button. Correctly installed driver will display in the Device Manager

(see figure).

Installation of AV USB 2.0 PRO device drivers in Microsoft® Windows®

XP

1. After connecting the AVUSB 2.0 PRO device to your computer,Found NewHardware
Wizard appears. To install the device driver, insert the installation CD of QuickPHOTO
Industrial 2.3 and press the Next button.

2. In the displayed dialog select Install the software automatically (Recommended) and
press the Next button.
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3. Complete the installation of the driver by pressing theFinish button. Correctly installed
driver will display in the Device Manager (see figure).

Installation of AV USB 2.0 PRO device drivers in Microsoft® Windows®

2000

Note

If you use Microsoft® Windows® 2000, Service Pack 4 must be installed before
installing the drivers. You can use either Windows® Update service or download
it from www.microsoft.com.

1. After connecting the AVUSB 2.0 PRO device to your computer,Found NewHardware
wizard appears. To install the device driver, insert the installation CD of QuickPHOTO
Industrial 2.3 and press the Next button.

2. In the displayed dialog select Install the software automatically (Recommended) and
press the Next button.

3. In the next dialog, you will be required to specify the location of the driver. Choose
CD-ROM option and press the Next button.

4. The system will search for a suitable driver on the CD. Continue by pressing the Next
button.

5. A warning that the driver has not passed Windows® Logo testing appears. Press the
Continue anyway button.

6. Complete the installation of the driver by pressing the Finish button. Restart of the
computer is necessary. Correctly installed driver will display in the Device Manager
(see figure).
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2. Installation of OLYMPUS® Consumer Digital
Camera (E-System, SP and CAMEDIA® series)

If you are going to use OLYMPUS® consumer digital camera for imaging, the following
steps need to be performed when installing QuickPHOTO Industrial 2.3:

1. Firmware check/update (OLYMPUS® E-330 only)
2. Switching the camera to PC control mode
3. Connecting the camera to a computer
4. Installation of the digital camera device drivers

2.1. Firmware Check/Update (OLYMPUS® E-330 only)

Note

There is no need to update the firmware when other types of OLYMPUS® digital
cameras are used.

To control the OLYMPUS® E-330 camera by QuickPHOTO Industrial 2.3 it is necessary
to have firmware version 1.2 or newer loaded in the camera. You can discover actual
version of the firmware by following procedure: turn on the camera, disconnect the USB
cable, press MENU button, go to Settings 2 (last tab), choose Firmware item (last item).
Firmware Body: 1.2 or newer is required. If you have older version of the firmware in your
camera, update it using OLYMPUS®MASTER program (the Internet connection is needed
for the update process) or contact authorized OLYMPUS® service.

Procedure of Firmware Update Using the OLYMPUS® MASTER
software:

1. Make sure the battery in the camera is fully charged and the USB cable is not
connected.

2. Turn the camera on. Look for the USB MODE item in the Settings 2 tab in the menu.
Select the STORAGE option.

3. Install OLYMPUS® MASTER program from a CD supplied with the camera.
4. Connect the camera to a PC via USB cable supplied with the camera.
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5. If you connect the camera to the PC for the first time wait until standard drivers for
the camera contained in operating system are installed.

6. Run the OLYMPUS®MASTER program. We recommend to close all other programs.
7. Click on Update Camera / Language icon. Press OK button.
8. Select newest firmware and press Update button. Press OK button.
9. Wait until the upgrade of the firmware is completed.

2.2. Switching the OLYMPUS® Consumer Digital Camera
to PC Control Mode

In order to be controlled from QuickPHOTO Industrial 2.3 the OLYMPUS® consumer
digital cameras need to be switched to the PC control mode. Proceed as follows:

• OLYMPUS® E-System SLR cameras:

Make sure no cable is connected to the camera. Switch the mode dial to the P position
and switch the camera on.

Note

To ensure that changes of camera settings will properly reflect in the live view
check the Live View Boost option is set to Off in the camera menu.

▪ OLYMPUS® E-330, E-510, E-410 SLR cameras

In the camera Settings 2 (the tool symbol with number 2) menu select theUSBMODE
option. Press the right arrow and select the CONTROL option. Confirm by pressing
the OK button.

▪ OLYMPUS® E-3, E-620, E-520, E-450, E-420 SLR cameras

In the camera Settings 1 (the tool symbol with number 1) menu or for E-620 model
Custom menu (the cogwheels symbol) select the DISP/sound/PC (the tool symbol
with D letter) option and press the right arrow. Select the USB MODE option and
press the right arrow. Select the CONTROL option and confirm by pressing the OK
button.

▪ OLYMPUS® E-600 SLR camera
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In the camera Settings menu (the tool symbol) select the Menu display option and
press the right arrow and select the ON option. Confirm by the OK button. Then in
the Custom menu (the cogwheels symbol) select the DISP/PC option and press the
right arrow. Select the USB MODE option and press the right arrow. Select the
CONTROL option and confirm by pressing the OK button.

After this procedure the camera is ready for PC control. After switching to PC control
mode, the camera will not be accessible as a Mass Storage disk unit. I you want to
download images from the camera via USB cable, the camera has to be switched to
STORAGE mode again in similar way. If switched to STORAGE mode the camera
cannot be controlled from QuickPHOTO Industrial 2.3.

• OLYMPUS® SP and CAMEDIA® series:

Make sure the USB cable and the TV output cable are disconnected from the camera.
Use the mode dial of the camera to turn the camera to P mode, turn it on and open the
cover of the memory card. The Card cover open warning appears. Then first press
OK/menu button (1) with Quick View (older models: switching the LCD on/off) button
(2). Hold down both buttons for 3 seconds. The CAMERA/SDK SETUP menu appears.
From USB menu select CONTROL (older models: ON), confirm with the OK button
and close the cover of the memory card. In this way, the camera is ready for PC control.
After switching to PC control mode, the camera will not be accessible as a Mass Storage
disk unit. I you want to download images from the camera, it has to be switched to
STORAGE (older models: OFF) mode the same way. If switched to STORAGE mode,
camera cannot be controlled from QuickPHOTO Industrial 2.3.
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2.3. Connecting the OLYMPUS® Consumer Digital
Camera to a Computer

Note

The AV USB 2.0 PRO device is equipped with following connectors:

• yellow CINCH connector for connection of analog video signal source
• red CINCH connector for connection of right channel of audio signal
• white CINCH connector for connection of left channel of audio signal
• black S-Video connector for connection of S-Video video signal source

For connecting the OLYMPUS® camera use yellow CINCH connector.

1. In order to control the camera (E-System and SP series), a special dual USB+Live
image cable is required. Connect the cable to the camera and then connect the USB
connector of the cable to a running computer. Connect the second cable with CINCH
connector to a device for displaying a live image. Use extension cords if necessary
(included in the package).

2. Set the Mode Dial to P position.
3. Turn on the camera.

2.4. Installation of OLYMPUS® Digital Camera Device
Drivers

• OLYMPUS® E-System SLR cameras:

The installation of OLYMPUS® E-System SLR camera device driver will be performed
during the application installation.

• OLYMPUS® SP and CAMEDIA® series:

The device drivers for OLYMPUS® SP and CAMEDIA® series cameras will be installed
automatically after a connection of switched on camera to the PC.
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3. IDS uEye® Digital Camera Installation
For correct function the IDS uEye® cameras require Microsoft® Windows® 7, Vista, XP
with SP3 (or newer) or 2000 with SP4 operating system.

Important

The IDS uEye® UI-1440 camera is not compatible with Microsoft® Windows®

7 operating system.

1. Do not connect the camera to your computer yet. If it is already connected, disconnect
it.

2. Continue with the program installation. The installation procedure for IDS uEye®

cameras is described in Installation of the application andCompleting the installation
sections.

4. ARTRAY ARTCAM Digital Camera Installation
1. Connect the camera to the USB 2.0 port of your computer.
2. Insert the QuickPHOTO Industrial 2.3 installation CD into your CD-ROM drive.
3. Continue installing the device driver as follows:

• Microsoft® Windows® Vista

Found New Hardware dialog appears. Click on Locate and install driver software
(recommended) option.
When the User account control window appears press the Continue button.
Then the dialog informing that Windows® couldn't find driver software for your
device will appear. Click on Browse my computer for driver software (advanced)
option. Locate the driver on the installation CD. You can find it in the
Drivers\ARTCAM 300MI folder for ARTCAM 300MI camera or in the
Drivers\ARTCAM500MI folder for ARTCAM 500MI camera. Press theNext button.
When Windows® Security window appears, click on Install this driver software
anyway option. Then close the dialog.

• Microsoft® Windows® XP
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The Found NewHardwareWizard appears. Check Install the software automatically
(Recommended) and press the Next button.
The system searches for suitable driver and asks you if you want to install it. Press
the Yes button and the camera driver will install.
The Found New Hardware Wizard appears once again. Now you will be asked to
enter the path to the camera driver. You can find it on the installation CD in the
Drivers\ARTCAM 300MI folder when using ARTCAM 300MI or in the
Drivers\ARTCAM 500MI folder when using ARTCAM 500MI.
Then press the Finish button.

5. OLYMPUS® DP72 Digital Camera Installation
Follow the instructions guide supplied with the camera for installation.

6. OLYMPUS® DP20 Digital Camera Installation
1. Connect the camera to the USB 2.0 interface of running computer and turn it on.
2. Insert the QuickPHOTO Industrial 2.3 installation CD into your CD-ROM drive.
3. Continue installing the device as follows:

• Microsoft® Windows® Vista

Found New Hardware dialog appears. Click on Locate and install driver software
(recommended) option.
When the User account control window appears press the Continue button.
Wait for an automatic installation of the driver. It can take a few minutes.
Press the Next button.
When Windows® Security window appears, click on Install this driver software
anyway option. Camera drivers will install.
Then press the Close button. Correctly installed driver will display in the Device
Manager (see figure).

• Microsoft® Windows® XP
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After the system finds the connected device, the Found New Hardware Wizard
appears. Check Install the software automatically (Recommended) and press the
Next button.
The system searches for suitable driver and asks you if you want to install it. Press
the Yes button and the camera driver will install.
Then press the Finish button. Correctly installed driver will display in the Device
Manager (see figure).

7. Installation of Lumenera® INFINITY Digital
Camera

Important

The Lumenera® INFINITY cameras are not compatible with Windows® 2000
operating system.

1. Do not connect the camera to your computer yet. If it is already connected, disconnect
it.

2. Continue with the program installation. The installation procedure for Lumenera®

INFINITY cameras is described in Installation of the application and Completing the
installation sections.

8. Installation of a Dongle
Connect a dongle to the USB port of your computer. If the Found New Hardware dialog
appears close it. The dongle driver will be installed during the application installation.

Note

If you have an LPT dongle (delivered with older versions of the software) the
ECP or ECP+EPP mode of the LPT port should be set in the computer BIOS for
correct functionality.
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9. Installation of the Application

Note

The installation of QuickPHOTO Industrial 2.3 needs to be made from the
administrator account (the user logged in should have administrative privileges).
If you are not a holder of an administrator account, please contact your PC
supervisor.

Important

Do not install any codec packs e.g. ffdshow, All In 1 or K-Lite Mega Codec Pack
to your operating system. These codec packs may cause incorrect operation of
the program. If some codec packs are installed, we recommend to uninstall them
first.

After logging in as an administrator, proceed as follows:

1. Insert the installation CD and install QuickPHOTO Industrial 2.3 following the
instructions of the wizard. First select the desired language and press the Next button.
The program will be installed in specified language. In the Select Components dialog
select the imaging devices you want to use. Their control panels will be installed.

2. During the installation, a a dongle driver installation wizard will appear. Select a
language and press the OK button. Then press the Next button. Check the I accept the
license agreement option and press the Install button to continue. Complete the dongle
driver installation by pressing the Finish button.

3. The video codec wmv9VCM installation wizard will appear. Start the installation by
pressing the Yes button and proceed according to the guidelines on the screen.

4. If the support for IDS uEye® digital camera has been selected, the installation program
for IDS cameras will appear. Press the Next button repeatedly till the Setup type
window appears. Select theDrivers option and press theNext button. On the following
wizard page press the Install button to start the installation. Finish the installation by
following the on-screen instructions. If the User account control window appears
press the Continue button.
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5. If the support for Lumenera® INFINITY cameras has been selected, keep the Lumenera
INFINITY camera drivers option on the Select Additional Tasks page checked. Then
you will be asked if the drivers for Lumenera® INFINITY cameras should be installed.
Confirm the installation and continue according to the instructions.

6. If the support for OLYMPUS® E-System SLR digital camera has been selected, there
will appear an E-System SLR camera control panel Setup Wizard. You will be asked
about the type of OLYMPUS® E-System SLR digital camera used. There are three
options available. One for OLYMPUS® E-330 camera, second one for OLYMPUS®

E-3, E-30, E-620, E-520, E-510, E-450, E-420, E-410 cameras and the third one for
OLYMPUS® E-600 camera. Next steps of installation differ according to the selected
option:

• In case of OLYMPUS® E-3, E-30, E-620, E-520, E-510, E-450, E-420, E-410 and
E-600 models the installation will be completed automatically.

• In case of OLYMPUS® E-330 model the E-system Camera Control Driver installer
will start. Follow the wizard guides.

Important

OLYMPUS® E-330 camera cannot be controlled from Microsoft® Windows® 7
and Vista operating systems. In those systems the E-330 option will not be
displayed. OLYMPUS® E-330 camera can be controlled only from administrator
accounts in Microsoft® Windows® 2000/XP.

Close the installer by Finish button and restart the computer.

Completing the Installation when OLYMPUS® E-330 SLR Camera is Used

1. After restart of the computer, log in the same administrator account which was used
for installation. A Camera Setup wizard will be launched automatically. Follow the
wizard instructions. If the wizard is not launched automatically, use the icon on the
desktop or start the program via ...\Program Files\Common
Files\OLYMPUS\service\setupcam.exe.

2. Continue following the on-screen instructions. You will be asked to turn the camera
off and on again during this procedure.
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Completing the Installation when OLYMPUS® Consumer Digital Camera
is Used (SP and CAMEDIA® Series)

Note

The OLYMPUS® consumer digital cameras cannot be controlled from a Guest
account.

If you are going to use the application from the administrator account, just turn the
OLYMPUS® digital camera on and launch QuickPHOTO Industrial 2.3. TheConfiguration
wizard will guide you through the application set up. Then the application should start to
communicate with the camera and be ready for use.

If you want to use the application from an user account (account with limited privileges),
the following procedure should be followed after the program installation (it applies to the
very first launch of the application only):

1. Turn the camera off and log out of the administrator account.
2. Log in using your user account and turn the camera on. Wait for the establishment of

communication between the camera and operating system (an icon will appear in the
system tray area).

3. Launch the QuickPHOTO Industrial 2.3.

Completing the Installation when IDS uEye® Camera is Used

1. After restart of the computer, log in the same administrator account which was used
for installation.

2. Connect the camera to an USB 2.0 port using the cable provided.
3. Continue with installing the driver as follows:

• Microsoft® Windows® Vista

Found New Hardware dialog appears. Click on Locate and install driver software
(recommended) option.

When the User account control window appears press the Continue button.

27

Installation



In Windows® Security dialog click on Install this driver software anyway option.
Then close the dialog.

• Microsoft® Windows® XP

The Found New Hardware Wizard appears. When using Windows® XP, you will
be asked for searching the driver in the Internet on the first page of the wizard.
Select No, not this time and press the Next button.

Check Install the software automatically (Recommended) and press theNext button.

The system will search for suitable driver and asks you if you want to install it.
Press the Yes button and the camera driver will install. The process needs to be
repeated to install the second driver. First the uEye boot is installed and then uEye
UI-xxxx Series driver is installed.

After this procedure the green LED on the camera should start glowing (if the LED is
present). That means the camera is installed and ready for use. If the red LED remains
glowing the camera is probably not connected to the USB 2.0 interface or there is some
problem with the driver installation. You can get an overview of the USB ports of your
computer using checkusb.exe utility which is located on installation CD of QuickPHOTO
Industrial 2.3 in CheckUSB folder. The checkusb.exe tool can also be downloaded from
www.promicra.com/downloads.php.

Completing the Installation when the Lumenera®

INFINITY Camera is Used

1. After restart of the computer, log in the same administrator account which was used
for installation.

2. Connect the Lumenera® INFINITY camera to an USB 2.0 port using the cable
provided.

3. Continue with installing the driver as follows:

• Microsoft® Windows® 7

The installation of the device drivers will be done automatically.

• Microsoft® Windows® XP
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The Found New Hardware Wizard appears. When using Windows® XP, you will
be asked for searching the driver in the Internet on the first page of the wizard.
Select No, not this time and press the Next button.

Check Install the software automatically (Recommended) and press theNext button.

The system will search for suitable driver and asks you if you want to install it.
Press the Continue button and the camera driver will install.

Correctly installed driver will display in the Device Manager (see figure):

Installation of Additional Imaging Devices

If you have the QuickPHOTO Industrial 2.3 already installed and want to add a support
for a new camera type, insert the installation CD of QuickPHOTO Industrial 2.3 into your
CD-ROM drive and run the installation program. You will be prompted to select desired
devices. Select one or more devices you want to add and continue the installation following
the wizard. All previous settings will remain unchanged, only the support for desired
cameras will be added.

9.1. Change of OLYMPUS® Consumer Digital Camera
Type (SP and CAMEDIA® series)

If you have already installed QuickPHOTO Industrial 2.3 with one of the supported
OLYMPUS® consumer digital cameras and want to use a different one (a new type or
another device of the original type) from the user account (account with limited privileges),
the following procedure must be performed:

1. Log in the operating system as an administrator.
2. Connect the new camera (switched to the PC control mode), set it to P position and

turn it on.
3. Wait until the new drivers will install.
4. Turn the camera off.
5. Launch Camera change program via Start → Programs → QuickPHOTO →

QuickPHOTO Industrial 2.3 → OLYMPUS CAMEDIA and SP Camera change.
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6. Press the OK button in Camera change window and close the dialog informing about
a successful change.

7. Log out of the administrator account.
8. After logging in to your user account switch the camera on. The QuickPHOTO

Industrial 2.3 will be ready to work with the new camera.

The procedure (camera change) should always be repeated before the very first use of a
new camera. If you decide to use the original camera, there is no need to perform this
procedure again.
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Initial Configuration of the
Application

Very first launch

Upon the very first launch of the program a Configuration wizard opens to assist you to
configure the application correctly. Most of the settings performed by the wizard can be
changed later manually from Edit → Settings... menu. The wizard can be also launched
again from Edit → Configuration Wizard...menu.

Important

Completing the wizard is mandatory when launching the QuickPHOTO Industrial
2.3 for the first time.

1. Configuration Wizard
The wizard consists of several pages. You can browse through them using the Next and
Back buttons. When changing settings, follow the wizard guides.

Imaging device selection

The second page of the wizard allows you to select the type of used imaging device. Only
the devices whose support has been installed are listed. Select the desired device and press
the Next button to continue.

Twain device selection

If you have selected TWAIN device a list of all available TWAIN devices appears. Select
the one you will use for capturing and press the Select button.

OLYMPUS® digital cameras (all types)

This page is available only if OLYMPUS® consumer digital camera or OLYMPUS®
E-System camera support has been installed. It is intended for setting up a device for
displaying a live image from OLYMPUS® digital cameras. If you have the live image
displaying device supplied with the software installed it is configured automatically when
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the page is displayed. If the device is not configured automatically select the appropriate
device from the Capture device drop-down menu and the input video signal standard from
Video standard drop-down menu. In the Input menu the appropriate input can be selected.
The Composite option should be checked. Check Keep image on memory card to retain
the image on the memory card after transferring to the PC (only for CAMEDIA® and SP
series). If this option is not checked the captured image will be deleted from the memory
card immediately after the transfer to a PC. It is recommended to retain the unchecked
state. Press the Next button to continue.

Live image from analog video sources

This page is available only if Analog video source support has been installed. It is intended
for setting up a device for displaying a video signal from analog video devices. If you have
the live image displaying device supplied with the software installed it is configured
automatically when the page is displayed. If the device is not configured automatically
select the appropriate device from theCapture device drop-down menu and the input video
signal standard from Video standard drop-down menu. In the Input menu the appropriate
input can be selected. Press the Next button to continue.
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Default folders

This page of the wizard allows you to set up the folders used as default ones for saving
images, measured values and reports. This eliminates the necessity of browsing through
the complete folder structure to select a folder where the images, reports or measured
values should be saved. Press the Next button to continue.
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Scale bar and units

This page of the wizard allows you to define the type and size of the calibred scale bar. In
the Scale bar type part, you can choose one of the following types of the scale bar: Bar,
Line, Staple. In the Scale bar size part you can select one of two automatic sizes of the
scale bar (Small, Large) or you can select the Custom size option and specify a custom
size of the scale bar in the Desired size field. The Preview part shows how the scale bar
will look like with current settings. In the Units of measured values part select units in
which the measured values will be displayed: micrometres or millimetres. Press the Next
button to continue.
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Initial measured quantities

This page is intended for setting up the quantities whose values will be measured by each
of the measuring tools (length, diameter, radius, perimeter, area, angle) and setting up the
letters for each of the measured quantities (Prefixes). The quantities to be measured should
be selected by checking the corresponding check boxes. To change the prefixes, rewrite
the letters in the relevant columns. When the Show measure numbers in the image option
is checked the corresponding sequential number will be displayed for each measured value.
These settings will became default for the program and for all new images. Press the Next
button to continue.

35

Initial Configuration of the Application



Automatic update from the Internet

This page of the wizard is used for setting up the automatic Internet update. One can select
to search for updates daily, weekly or monthly. If you do not want to search for updates
or if you are not connected to Internet, do not check Enable the automatic update from the
Internet option. It is recommended to keep the function active if possible. Press the Next
button to continue.

36

Initial Configuration of the Application



External trigger

This page is intended for setting up and verifying the external trigger function. External
trigger is an optional accessory that can be connected via the serial or USB interface. If
you want to use an external trigger, check the Use external trigger option and select the
COM port (an USB Serial Port (COM X) port in case of USB trigger) which it is connected
to. In the Trigger type part choose the appropriate type of the trigger. The trigger with two
buttons (e.g. two-button foot switch) is intended for capturing images and recording video
files using RECORD IT module. Check the functionality of the trigger by pressing its
button/s. If, when pressing the button/s, the square/s change/s colour to green and then
back to black after release, the external trigger is connected correctly and is ready for use.
Press the Next button to continue and then press the Finish button.
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2. Calibration of the Application for
Measurements

Prior to measurement, calibration of the application is required for the microscope + imaging
device set.

Calibration is necessary for each lens (objective) you want to use. In case you want to use
more types of imaging devices, calibration is required for each of the imaging device
separately. For the purposes of calibration, you will need an objective micrometer.

Following is an example of calibrating uEye® UI-2250-C digital camera and objectives 4,
10, 20 and 40x (the procedure for other imaging devices is similar):

1. Insert the objective micrometer to the microscope and focus at the calibrating scale
bar at the lowest magnification used.

2. In the Measurements menu select Calibration manager... option. In the Calibration
dialog press the Add button and select the type of the imaging device used from the
drop-down menu. Each camera type may have its own calibration that you can switch
among depending on the currently used camera. In our example, it is uEye® UI-2250-C.
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After selecting the Custom option you can type an arbitrary name of the camera. In
the Microscope type field, enter the type of microscope used. One camera can be
calibred for several microscopes this way. Press the OK button.

3. In Calibration manager within Magnification part, press the Add button. On Starting
information page, enter the value conforming to the lens used in the Magnification
text field. In our case, enter "4" and press the Next button.
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Note

You can enter the whole microscope magnification (e.g. 40, 100, 200, 400) instead
of the lens magnification (4, 10, 20, 40).

4. The Image selection dialog pops up. Check the Acquire the image from the actual
capture device option and press the Next button. The Control panel of the imaging
device will be activated. If you select Use the current image, the current image from
View window will be opened in the window for calibration. Set up the imaging device
and the microscope to capture the image of a calibration scale bar. Press the Capture
button to take a snapshot of the calibration scale bar.

Warning

When using the OLYMPUS® consumer digital camera (SP and CAMEDIA®

series) it is necessary to eliminate the auto focus to get the correct results. This
can be done by selecting the Manual focus mode and setting the Focus slider to
infinity.

5. In the displayed image, insert the line segment (by dragging the mouse while pressing
the left button) to demarcate the maximum number of sections of the calibration scale
bar. Guide the line segment from the left edge of the first line to the left edge of the
end line, see figure. You can modify the line segment by re-dragging if necessary.
Use the icons on the left-hand window side to enlarge the image if necessary. In case

the image quality is poor, click icon to reactivate the control panel of the imaging
device and take a new snapshot. Calculate the real size of the demarcated area by the
number of sections and enter the appropriate value in Real line segment length field
(in our case 1000 μm). Press the Next button.
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6. On the last page, there is information about performed calibration displayed. Finish
the calibration by pressing the Finish button. The magnification will be added to the
list.

7. Repeat steps 3 – 6 for all objectives used.

On the right-hand side of theCalibration manager dialog, there is a graph that should have
all points placed on the same straight line. If this is not the case (a polyline is displayed),
some of the values have been entered incorrectly. In this case, recalibrate the wrongly
calibred objective until all the points will be placed on the straight line.
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Similarly perform calibration for other imaging devices used. To change the active
calibration, first select appropriate item in the Calibration list and then press the Set active
button. The active calibration can be also quickly changed using Measurements → Active
calibration option from the menu of the main program window.

You can delete the calibration by selecting the relevant item in the list and pressing the
Remove button. Use the Edit button to modify the calibration.

Created calibrations can be saved on the hard disk for backup purposes and loaded again
when necessary. To save the calibrations, press the Backup calibrations button and select
the location and file name. Press the Load calibrations button to load the saved calibrations
from a file.

Locking the Calibrations
The created calibrations can be locked to prevent changes. After calibration of all used
imaging devices and objectives press the Lock calibrations button. You will be asked to
enter a new password. Type a password and confirm by typing it again. Then press the OK
button. The calibrations will be protected against changes until the Unlock Calibrations
button is pressed and a correct password entered.
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Main Window of the Application
The application Main window is an image editor where the images are displayed
immediately after the capture. This editor features many functions for image editing, saving
and measurements. The Main window is capable of working with multiple images at the
same time. For your convenience, previews of all of the opened images are displayed in
the Thumbnail panel on the left hand side of theMain window. TheNavigator panel allows
you to easily orientate in the zoomed image.

The following functions for image editing are available:

• crop
• flip/mirror
• rotate
• resize
• colour balance, brightness and contrast adjustment
• inserting text labels into an image
• use of filters (sharpen, blur, negative, grey scale)
• insertion of drawings (tools: line, arrow, rectangle, circle, ellipse, polygon, freehand)

QuickPHOTO Industrial 2.3 is equipped with following measurement functions:

• insertion of a calibred scale bar (with the options to define the appearance and position
of the scale bar)

• Brinell hardness measurement (according to EN ISO 6506-1)
• Vickers micro-hardness measurement (according to EN ISO 4516)
• measurement of lengths (line segment, polyline tools)
• measurement of perimeters (ellipse, rectangle, circle, polygon, arc tools)
• measurement of diameters (circle, arc tools)
• measurement of angles (arbitrary angle, angle formed by horizontal axis, angle formed

by vertical axis, angle defined by two line segments)
• measurement of distance between parallel lines
• measurement of radius, angle and length of the arc
• display of calibred grid (rectangular, circular)
• objects counting
• phase analysis
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All inserted objects (drawings, text labels and measurements) are stored in a separate layer
“over the image” and may be modified at any time (change of colour, line thickness, size,
placement), deleted, hidden, or the layer with the inserted objects can be merged with the
image layer.

1. Graphical User Interface Description
The Main window is divided into several parts:

• Menu bar - used to activate the program functions
• Tool bar - contains individual tool icons
• Thumbnail panel - displays all opened images
• Navigator - used for navigation in a zoomed image and fine zooming
• View window - used for work with the actual image
• Table of measured values - contains the measured values
• Status bar - displays the information on the current state of the application
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The proportions of the above mentioned parts of theMain window can be changed. Proceed
as follows: position the mouse cursor on the edge separating the parts. The mouse cursor
changes to . Press and hold the left mouse button and drag the mouse to define the part
size. Then release the mouse button. The proportions will be saved and applied upon the
next launch of the application. Using the small buttons with arrows you can hide the
Thumbnail panel, the Navigator or both of them. Click to display the hidden panels
again.

1.1. Menu Bar

File

The File menu contains the following functions: Open... – opens the images to work with.
In the dialog box you can take multiple images to a selection and load them all at once.
Save – saves current image. Save as... – saves the image with defined filename in the
required image format (JPEG, TIFF, BMP). If saving as a JPEG file type a dialog appears
for choosing the compression ratio. Save all – saves changes in all opened images. Save
measured values... – saves values measured in the image in Microsoft® Excel format file
or as a plain text file. Close all – closes all opened images. Close selected – closes the
images marked in the Thumbnail panel. Capture – opens the control panel of the current
imaging device. Recent files... – this sub menu displays last up to ten opened images for
easy reopening. Print setup... – used for print configuration.Print – starts printing according
to the current setting. Exit – terminates the application.
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Edit

The Edit menu contains the following functions: Undo – reverts the last performed action.
In this way, you can revert any number of performed steps. Redo – repeats the last reverted
action. Copy – copies the selection or whole image to the clipboard. Paste – pastes from
clipboard. Use Object colour and Line width to change the line colour and thickness of all
measuring a drawing objects. Restore original image – returns the image to the original
captured or opened state. Clear all inserted objects – deletes all drawn objects, text labels
and measuring objects from the image. Flatten image – merges the layer containing the
drawn and measuring objects with the image layer. Configuration wizard – opens the
QuickPHOTO Industrial 2.3 configuration wizard and Settings... – opens the dialog for
setting up the individual application parameters.

Image

Image menu contains functions for working with the actual image (rotate, flip/mirror, crop,
resize, sharpen, blur, negative, grey scale) and functions for adjustments of the brightness,
contrast and colour balance of the image.

View

The View menu contains following options: Image information... – displays information
on the current image, including meta data (if any), Show inserted objects – is used to
display/hide all drawn objects, text labels and measuring objects in the current image. Show
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measured values in image hides or displays the numerical values for all measuring objects
in the current image. Show table of measured values – displays/hides a Table of measured
values. Zoom all – displays the current image fitting the View window, Zoom in – enlarges
the current image, Zoom out – reduces the current image and Original size – displays it at
100% magnification where one image pixel corresponds to one screen pixel. Presentation
mode – turns on the full-screen slide show of all or selected images. Full screen – displays
the image(s) from the View window in full screen mode. Show orthogonal grid and Show
circular grid – are used to display/hide the calibred grid.

Measurements

Measurements menu contains measuring and calibration tools. They include inserting the
horizontal or vertical scale bar, measurement of an arbitrary distance, perimeter and area
of an ellipse, rectangle and polygon, perimeter, diameter and area of a circle, length of a
polyline, counting of objects, measurement of angles, distance between parallel lines,
perimeter, diameter and angle of an arc, phase analysis, and Vickers and Brinell hardness.
Units - this sub menu allows quick change of units used to display measured values. Active
calibration – this sub menu helps with quick change of active calibration. Calibration
manager... – is used for creating, modifying and switching between calibrations. For more
information about measuring tools see “Measurements“ on page 68.
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Devices

Devices menu is used for selecting the type of imaging device or other types of devices
(e.g. microscope, stage). Only those devices whose support was installed are displayed.

Modules

Modulesmenu is used for activation of the modules, e.g. Timer, Time lapse video (standard
parts of the application) or the optional modules.

Reports

Reports menu contains functions for creating reports in Microsoft® Word format. Create
template – activates the wizard for creating a template. Template manager... – allows to
change the name of existing templates and delete the unused ones see “Creating
Reports“ on page 86.
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Window

Restore layout– is used for restoring the original layout of all the parts of the main program
window.

Help

Help menu contains the following items: Help... – opens the electronic user guide. You
can also use the [F1] key. What's new... – opens a document containing information about
new functions of actual program version. Program update... – opens the tool for searching
for application updates on the Internet. Send dongle number... – is used for displaying and
sending the dongle number. This is necessary for application upgrade or for getting new
modules. About... – displays information on QuickPHOTO Industrial 2.3.

1.2. Tool Bar

The application functions can be activated using the icons on the tool bar.

Open: opens the image from available disk drives. [Ctrl+O]

Save: saves image(s) selected in the Thumbnail panel. [Ctrl+S]

Print: prints the current image. [Ctrl+P]

Image information: displays information on the current image (including meta data,
if any). [Ctrl+I]
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Undo: reverts to the last image modification. [Ctrl+Z]

Redo: repeats the last reverted operation. [Shift+Ctrl+Z]

Copy: copies the selected area or the whole image displayed in the View window to
the clipboard. [Ctrl+C]

Paste: pastes the contents of the clipboard as a new image. [Ctrl+V]

Select area: click the icon to make a selection by pressing the left mouse button and
dragging the mouse.

Rotate clockwise: rotates current image 90° clockwise.

Rotate counter-clockwise: rotates current image 90° counter-clockwise.

Flip image: flips current image vertically.

Mirror image: mirrors current image horizontally.

Resize: opens a dialog box to resize current image.

Crop: crops the image after making a selection. Only the selected part of the image
will remain. The rest will be removed.

Adjust brightness/contrast: opens a dialog for image brightness/contrast adjustment.
In the lower part, there are previews of the image before and after the adjustment.
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Adjust colours: opens a dialog where colour balance can be changed. You can adjust
the red, green and blue colour channel independently. In the lower part, there are
previews of the image before and after the adjustment.

Magnification: to get the correct results before inserting the calibred
scale bar or before the measurement, choose the correct
magnification at which the image was taken.

Insert horizontal scale bar: inserts the calibred horizontal scale bar in the lower
right-hand corner. The displayed value specifies the length of the whole scale bar.

Insert vertical scale bar: inserts the calibred vertical scale bar in the upper right-hand
corner. The displayed value specifies the length of the whole scale bar.

Measure arbitrary distance: after clicking the icon, you can insert a measuring line
segment in the image by dragging the mouse while holding down the left button.

Measure ellipse: after clicking the icon, you can insert a measuring ellipse in the
image by dragging the mouse while holding down the left button.

Measure rectangle: after clicking the icon, you can insert a measuring rectangle in
the image by dragging the mouse while holding down the left button.

Measure circle: click to display the following options Circle defined with radius,
Circle defined with diameter and Circle defined by three points. Choose one of the
options to insert a measuring circle in the image by dragging the mouse while holding
down the left button, or define three points of the circle.

Measure polygon/polyline: click the icon to insert either a measuring polygon or
polyline. Click on the desired place to enter the first polygon vertex. Enter other
polygon vertexes by clicking the left mouse button. Click right mouse button to
finish the polygon or polyline drawing.

Count objects: click the icon and mark the objects you want to count with the left
mouse button.
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Measure angle: choose the measurement type after clicking the icon: Measure
arbitrary angle, Measure angle from X axis, Measure angle from Y axis, Angle
between two lines. Click on the image and drag the mouse or enter the points to
enter the angle arms, see “Measurements“ on page 68 for more information.

Measure distance between parallel lines: click and draw the first line segment in
the image and then click to locate the second parallel line.

Measure arc: click in the image to define the three points on the arc.

Phase analysis: opens the control panel of the phase analysis tool.

Show orthogonal grid: used to display a rectangular grid of defined dimensions.

Show circular grid: used to display a circular grid of defined dimensions.

Show table of measured values: displays/hides the Table of measured values.

Single image: displays only one image in the View window.

Two images: used to display two images side-by-side in the View window.

Four images: used to display four images side-by-side in the View window.

Capture: activates the control panel of the active imaging device (selected in the
Devices menu). The arrow to the right of the icon is used for quick selection of
the imaging device.
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Timer: activates the Timer panel allowing time lapse imaging with adjustable time
interval.

Time lapse video: activates the Time lapse video module intended for creating
video-files from time lapse images.

Zoom all: displays the image fitting the View window.

Zoom in: enlarges the current image.

Zoom out: reduces the current image.

Original size: displays the image at actual size (100%).

Object colours/line thickness: used to change the colour and thickness of a line
for the inserted objects. The left-hand part of the icon changes the colour while
the part with an arrow changes the thickness. The icon is also used as an indicator
of current colour and line thickness.

Select: used for selection of the drawn or measured objects.

Clear selected: deletes the objects selected with the Select tool. [Del]

Clear all inserted objects: deletes all drawn objects, text labels and measuring objects
from the image.

Draw line: click this icon to insert a line segment in the image by dragging the mouse
while pressing the left button.
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Draw arrow: click the icon to insert an arrow by dragging the mouse while pressing
the left button. The arrow will point to the place where you release the left button.

Draw rectangle: click the icon to insert a rectangle by dragging the mouse while
pressing the left button.

Draw circle: click the icon to insert a circle by dragging the mouse while pressing
the left button.

Draw ellipse: click the icon to insert an ellipse by dragging the mouse while pressing
the left button.

Draw polygon: click the icon to insert a polygon. Click on the desired place to enter
the first polygon vertex. Enter other polygon vertexes by clicking the left mouse
button. Click the right button to finish the polygon drawing. The polygon will be
closed.

Draw freehand: click the icon to draw freely by dragging the mouse while pressing
the left button.

Insert text: activate the tool and select a place in the image to position the text by
clicking the left button. A field for entering the text will appear.

Font: drop-down menus are used for selection of
font type and size of entered text.

Text colour: used for font colour selection.

Measure Brinell hardness: click the icon to start measuring the Brinell hardness.

Measure Vickers hardness: click the icon to start measuring the Vickers
micro-hardness.
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1.3. Thumbnail Panel

The previews of opened images are displayed in the Thumbnail panel with their names
and sizes. If you move the mouse over the preview, four buttons will appear next to it. The
first button ( ) saves the image. Press the second one ( ) to open the image in View
window. The other option is to click on the preview with the left button and drag it to the
View window or to double-click the preview. If you use the display of two or four images
side-by-side mode select the field where you want to display the image first. The third
button ( ) is used for marking the preview as important. The image preview will be framed
in red.

If the image is modified, an asterisk is displayed in front of its name. Click the cross ( )
to close the image. If any changes were made to the image, you will be asked to save it.
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1.4. Navigator

TheNavigator for the current image is displayed in the left-hand
bottom part of the Main window. The frame inside indicates the
part of the image that is visible at the current zoom in the View
window. You can move the frame using the mouse to view the
highlighted area in the View window. The slider under the
Navigator window is used for changing the zoom of the current
image. TheNavigator can be hidden and then shown again using

button.

1.5. View Window

The View window is the main part of the application where all the operations performed
to the image take place. If you need to work with several images at a time, the View window

can be split into two or four parts by clicking or icon.

1.6. Table of Measured Values

The Table of measured values is located at the bottom of the View window. This window
contains several tabs depending on the number of images displayed in the View window.
The measured values are displayed in a tabular tables on Image 1- Image 4 tabs. Each tab
contains values measured in one of up to four images displayed in the View window.

Using theMeasurement settings - Image... tab the measurement parameters can be adjusted
for the current image and if necessary, the calibration assigned to that image can be changed.

For more information on Table of measured values see “Work with Table of Measured
Values“ on page 83.

1.7. Status Bar

Status bar, which is located at the very bottom of the Main window, displays the following
information:

• name of the image displayed in the View window
• size of the image file in kB (MB), if it is known
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• dimensions of the image in pixels, if the image has calibration information assigned,
the actual dimensions (in µm or mm) are displayed in parenthesis

• zoom of the current image
• if there is a selection in the image, the size of the selection is displayed in pixels
• name of the active imaging device
• active calibration assigned to the current image

2. Capturing of Images
In the Devices menu, you can find a list of imaging devices whose support you have
installed. If you want to add a device to the list, see “Installation of Additional Imaging
Devices“ on page 29. To take an image, proceed as follows.

2.1. Selection of an Imaging Device

OLYMPUS® digital camera

Check the option if you wish to use an OLYMPUS® consumer digital camera (CAMEDIA®

or SP series) for imaging.

OLYMPUS® E-system SLR digital camera

Select this option for capturing with the OLYMPUS® E-System SLR digital camera.

uEye® digital camera

Select this option when using one of the IDS uEye® cameras. The camera type will be
recognized automatically.

Lumenera® INFINITY digital camera

Select this option when using one of the Lumenera® INFINITY cameras. The camera type
will be recognized automatically.

ARTRAY ARTCAM camera

Select this option when using one of the ARTRAY ARTCAM cameras. The camera type
will be recognized automatically.
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OLYMPUS® DP72 camera

Check this option for imaging from the OLYMPUS® DP72 camera.

OLYMPUS® DP70/DP71/DP30BW camera

Check this option for imaging from the OLYMPUS® DP70/DP71 or DP30 camera.

OLYMPUS® DP20 camera

Check this option for imaging from the OLYMPUS® DP20 camera.

Basler A601fc, JVC KY-F1030, PixeLINK PL-A662 digital cameras

If you have connected one of these digital cameras and want to use it, select it in Devices
menu.

Analog video source

Check this option if you want to capture images from an analog video device. You can
capture images e.g. from an analog camera, video endoscopic systems, VCR or DVD.

TWAIN device

Select TWAIN device… option if you want to use scanner or another TWAIN device (some
cameras also support this interface). The dialog with the list of installed TWAIN devices
will open.

Note

Devices controlled via the TWAIN interface do not cooperate with the modules
(e.g. Time lapse image capturing).

2.2. Activating a Control Panel of Imaging Device

To activate the Control panel of the selected imaging device, click on icon. For more
information see “Control Panels of Imaging Devices“ on page 109.
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2.3. Capturing the Images

To capture an image first set the exposition parameters and then press the Capture button
or use the [Ctrl + Enter] shortcut. Other option is to use the external trigger (optional
accessory). The image will be then transferred to the computer. For further information
see “Control Panels of Imaging Devices“ on page 109.

3. Image Processing
The QuickPHOTO Industrial 2.3 is equipped with many functions for handling images.

3.1. Opening Images

Open images from menu File→Open, by clicking icon or using the [Ctrl+O] shortcut.
Select the required images in the dialog box and press the Open button. Other option is to
drag and drop the file into the View window (e.g. from Windows® Explorer or other file
manager). The previews of all opened images are displayed in the Thumbnail panel with
their names and sizes.

3.2. Editing Images

Crop to selection
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To crop the image, click icon and select the image area
you want to retain by clicking and dragging the mouse with
the left mouse button pressed. In the left-hand corner of the
selection, you will see the size of the area selected. The size
is shown in pixels and if a calibred magnification is assigned
to the image, also in length units. Click the frame with values to switch to the mode where
the selection size can be defined.

Initially the icon of an opened lock is displayed next to the editable boxes. It means each
dimension of the region can be entered independently. After clicking on the lock icon it
changes its appearance to a closed lock and the constrain proportions functions will activate.
It means the entered ratio will be remembered. After that one dimension can be entered
freely and the second one will be calculated automatically maintaining the remembered
ratio. The pixels or length units can be selected.

Confirm by pressing [Enter] or the OK button. The region will be resized according to the
values entered. The displayed values can be hidden for better orientation by pressing the

button next to the displayed values. For displaying the values again press the button.

Use the mouse to move the selection or change its size. Press [Esc] to cancel the selection.
Perform the crop by double clicking the left mouse button inside the selected area of the

image, by pressing [Ctrl+Enter] or clicking the icon again. Only the selected area of
the image will remain. The rest will be removed.

Flipping/mirroring and rotating the image

You can flip/mirror the image by the horizontal/vertical axis respectively. To flip, click

icon. To mirror, click icon. To rotate the image 90° clockwise, click icon. To

rotate the image 90° counter-clockwise, click icon.
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Resizing the image

To resize the image, click icon. The Resize dialog
box appears. When Constrain proportions is checked,
just enter one new dimension and the second will be
calculated maintaining the aspect ratio. If you uncheck
the box, you can change both the dimensions
independently (distortion may occur).

Brightness, contrast and colour balance
adjustment

To adjust brightness and contrast, click icon. Adjust
dialog with Brightness/Contrast tab active opens. Use
the sliders to set the brightness and contrast required. In
the lower part, there are image previews before and after
the adjustment. The+ and – buttons between the previews
are used for changing the preview zoom. Click and drag the mouse to move the left preview.

To adjust the colour balance, click icon. Adjust dialog with Red/Green/Blue tab active
opens. Use the sliders to set the colour balance values or enter their values in the text fields
on the right-hand side. In the lower part, there are image previews before and after the
adjustment. The + and – buttons between the previews are used for changing the preview
zoom.
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3.3. Marking and Labeling of Interesting Areas in the
Image

QuickPHOTO Industrial 2.3 allows the following objects to be entered to mark the
interesting areas:

• straight line
• arrow
• rectangle
• circle
• ellipse
• polygon
• freehand drawing
• text label
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Line colour and thickness selection

The icon is divided in two parts. Click the left part of the icon to select colour. Click
the right part of the icon to select line thickness for the inserted objects.

Drawings

Line drawing

Click icon, place the mouse cursor at the starting point, press and hold down the left
mouse button and then drag the mouse. Release the mouse button when the line reaches
the desired length.

Arrow drawing

Click icon, place the mouse cursor at the starting point, press and hold down the left
mouse button and then drag the mouse. Release the mouse button when the arrow reaches
the desired length.

Rectangle drawing

Click icon, place the mouse cursor to the first corner of the rectangle, press and hold
down the left mouse button and then drag the mouse. Release the mouse button when the
rectangle reaches the desired shape.

Circle drawing

Click icon, place the mouse cursor at a centre of the circle, press and hold down the
left mouse button and then drag the mouse. Release the mouse button when the circle
reaches the desired size.

Ellipse drawing

Click icon, place the mouse cursor at centre of the ellipse, press and hold down the
left mouse button and then drag the mouse. Release the mouse button when the ellipse
reaches the desired size.
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Polygon drawing

Click icon, click on the desired place to enter the first polygon vertex. Enter other
polygon vertexes by pressing the left mouse button. Press the right button to finish the
polygon drawing. The polygon will be closed.

Freehand drawing

Click icon, place the mouse cursor at the starting point, press and hold down the left
mouse button and then drag the mouse to continuously draw freehand. Release the mouse
button to finish the freehand drawing.

Inserting text labels

Click icon, place the mouse cursor at the position where you want to insert the text
label and press the left mouse button. Text entry field appears. Enter the text and press the
[Enter] key.

Handling Drawn Objects and Text Labels

Changing the size and position of drawn objects and text labels

In case you do not have any other tool active, Select tool is automatically active. This
tool allows any object to be selected and modified. Select the object by clicking on its
boundary with the left mouse button. (To handle more drawn objects at once, hold the
Shift key and mouse click to highlight all objects you want to change.) The object will be
framed or dashed with a green line with grasping points. To cancel the selection, click
anywhere else in the image or select another object.

If you want to move the object, place the mouse cursor over it. The cursor changes to .
Drag your mouse while pressing the left button to move the object. Ellipse, rectangle and
polygon objects have a cross in the centre. Use the cross to move the objects. Proceed
identically when changing the position of text labels. The ellipse object has an extra green
square connected to the centre using a dashed line. Use the square to rotate the ellipse.
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To change the object size move the mouse cursor over one of the green squares. The size
change indicator appears. Click and drag to change the object size. The text labels cannot
be resized.

Changing colour and thickness of lines of the drawn objects

Select an object with tool and change the colour by clicking on the left-hand part of

icon and selecting a new colour. Change the line thickness of the object by clicking
on the right-hand part of the icon and selecting a new thickness.

Modification of text labels

Select the text label with tool to change the colour, font type and font size using the

tool bar. Click icon to change the font colour. Select the font size and type from the
drop-down menu. To change the text label, click in the text and modify it.

Deleting a drawn object or text label

Select the object or label with tool. Click icon or press [Delete] to delete the selected
object from the image. If you want to delete all drawn objects, use Edit→Clear all inserted

objects option or click the icon.

3.4. Saving Images

QuickPHOTO Industrial 2.3 allows saving of images with inserted objects and
measurements in JPEG and TIFF file formats without losing the possibility to edit the
objects when the image will be later opened in QuickPHOTO program. The layer “over
the image” will be retained with the same functionality as before saving the image. In other
applications, the layer (all inserted objects and measurements) will be ignored and only
the image without these objects will display. If you want to open the image in some other
application with the objects displayed, it is necessary to flatten the layers before saving
the image via Edit → Flatten image. The inserted objects and measurement data will
become a solid part of the image without the option of further adjustments or removal and
the layer “over the image” will be discarded. The inserted objects and measurements will
then be displayed in any image viewing application. Flattening of the image must be done
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before saving the image in BMP format. Otherwise you will not be able to save the image
in BMP format.

The File menu contains several options for saving images:

Save

This option saves images selected in the Thumbnail panel (blue framed). If the image was
recently captured by an imaging device this option has the same effect as Save as... option.
If the image is opened from a disc this option will overwrite the original file with the actual
version.

Save as...

This option saves the marked image (blue
framed) in the Thumbnail panel as a filename
in JPEG, TIFF or BMP file format. Enter the
new filename or retain the original one,
select the image format and location. When
saving in JPEG file format, you will be asked
for the compression ratio. Press Calculate
button to find out the resulting file size after
compression. If you keep the option Do not
change the image compression, the image
will be saved at the current compress level.
When the image was modified this option is not available.

Save all

This option saves all images opened in the Thumbnail panel.

Other options for saving images

You can also use icon in the tool bar or the button from the thumbnail control
panel. The saving function is identical to File → Save option.

When quitting QuickPHOTO Industrial 2.3, you will be asked whether you want to save
the unsaved images or not. If you press Yes to all, you will save all the images, No to all
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means all images will be discarded. Use Yes and No buttons to define whether you want
to save the particular file or not.

3.5. Printing Images

In Filemenu, there is Print setup… option to open the dialog where you can set the printing
parameters (paper orientation, print size, print information on the image, margin width and
font size of the measured quantities).

The drop-down Image print setup menu contains three options:

Fit to page - the image will be printed on the whole page.
Original size - the image will be printed while retaining its original size.
Custom size - allows you to define the size at which the image will be printed. Enter the
size in Custom size fields. When Constrain proportions option is checked, just enter one
dimension and the other will be calculated automatically.

In Borders part of the window you can set the size of individual margins in millimetres.
When selecting Collage in Image selection, all images displayed in View window will be
printed. If you wish to print the current image with the date, time and name, check these
options in Information part. Press the Print button to start printing. If you wish to print

other images with the same settings, just select Print from File menu or click icon.
The image will be printed out retaining the previous settings.

67

Main Window of the Application



Print profiles:

Print profiles are used for easy and quick
print parameters setting.

Use: Set the print parameters and press
the button with the floppy disk symbol.
You will be prompted to enter a name
for the profile. Later, you can set the
print parameters by selecting the required
profile from the drop-down menu.

You can set up to ten different profiles.
The application contains several
predefined profiles for printing to
OLYMPUS® P-10 and OLYMPUS®

P-11 printers.

4. Measurements
QuickPHOTO Industrial 2.3 enables measuring in the image. The following measuring

functions are available: arbitrary distance ( tool), perimeter and area of an ellipse (

tool), perimeter and area of a rectangle ( tool), perimeter, area and diameter of a circle

( tool), perimeter and area of a polygon ( tool), length of a polyline ( tool), angles

( tool), distance between two parallel lines ( tool), length, angle and radius of an

arc ( tool) and object count ( tool). Calibred scale bar can be inserted by and
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tools. Brinell hardness ( tool) or Vickers micro-hardness ( tool) can be also

measured as well as a phase analysis ( tool).

To use the measuring functions, QuickPHOTO Industrial 2.3 needs to be calibred first,
see “Calibration of the Application for Measurements“ on page 38. You can activate the
measuring functions from the Measurements menu or using the icons in the Tool bar.

4.1. Preparation for Measurement

Magnification selection

To achieve correct measurement results and scale bar calibration, select the magnification
used during image capturing from the drop-down menu first. The list contains the
magnification values for which the calibration was made. The magnification selection
should always be made prior to measuring in the current image. Until that the measuring
functions remain unavailable.

Line colour and thickness selection

To get the optimal visibility of the measuring objects, you can change the line colour of
the measuring objects using Edit → Object colour function or by clicking the left part of

icon. Click the right part of the icon or use Edit → Line width option to select the
thickness of the lines of the measuring objects.

Measurement settings

The default measurement settings are automatically assigned to all newly-acquired images
and opened images which have not been saved by QuickPHOTO program. These settings
can be changed in the Settings window (Edit → Settings...). QuickPHOTO Industrial 2.3
allows you to adjust these settings for actual image independently in the Table of measured
values on theMeasurement settings - Image... tab. Using check boxes you can set up which
quantities you want to measure with a specific measuring object and in the last row how
they should be described. Font size of measured values and scale bar, thickness and colour
of auxiliary lines and display of measurement numbers in the image can be set.
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4.2. Scale Bars

Inserting a calibred scale bar

A calibred scale bar can be inserted into the current image displayed in the View Window.

Click icon to insert the horizontal scale bar into the lower right-hand corner of the

current image or click icon to insert the vertical scale bar into the upper right-hand
corner of the current image. Click the same icon again to hide the scale bar. The value
under the scale bar specifies its overall length. If you want to change the type of displayed
scale bar, click the right mouse button on the scale bar. A menu appears containing the
Scale bar settings... option. By selecting this option, the Settings window will open on the
Scale bars tab where you can make the modifications, see “Settings“ on page 96, section
Measurements, Scale bars tab. The menu also contains a list of four predefined profiles.
By selecting one of them, the scale bar will change its appearance immediately according
to the settings stored in the selected profile.

Scale bar setting

In Edit → Settings... menu select Scale bars tab where you can perform desired
modifications.

4.3. Measuring Tools

Activate the measurement by clicking on one of the icons in the Tool bar or by activating
the required function from the Measurements menu.

70

Main Window of the Application



Measurement of arbitrary distance (length)

Activate the measurement of length from Measurements → Measure arbitrary distance

menu or click icon. Then, start measuring of the desired dimension in the image by
inserting the measuring line segments. Press the left mouse button and drag the mouse.
Then release the mouse button. After the first line segment is inserted you can continue
with inserting another one. Finish the measurement by pressing the right mouse button,

by clicking icon again or by [Esc] key.

Measurement using ellipse tool

Activate the measurement from Measurements → Ellipse menu or click icon. Then
insert the measuring ellipse into the image by dragging the mouse while depressing the
left button. Perimeter and area can be measured.

Measurement using rectangle tool

Activate the measurement from Measurements → Rectangle menu or click icon. Then
click and drag the mouse to insert the measuring rectangle. Perimeter an area can be
measured.

Measurement using circle tool

Activate the measurement from Measurements → Circles menu or click icon. Select
one of three possibilities for inserting the measuring circle.

1. Circle defined with radius - click and drag your mouse to define the radius of the
circle (from the centre).

2. Circle defined with diameter - click and drag your mouse to define the diameter of
the circle.

3. Circle defined with three points - click three times in the image on points which will
define a circle.

Diameter, perimeter and area can be measured.
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Measurement using polygon tool

Activate the measurement from Measurements → Polygon menu or click icon and
select Polygon from the displayed menu. Click on the desired point of the image to enter
the first polygon vertex. Enter other polygon vertexes by clicking the left mouse button.
Complete insertion of the polygon by clicking the right mouse button. The last vertex will
connect the first one and the polygon will be closed. If the polygon sides intersect, the
polygon area will not be calculated (0 will be displayed) and only the perimeter will be
calculated. Perimeter and area can be measured.

Measurement of polyline length

Activate the measurement from Measurements → Polyline menu or click icon and
selectPolyline from the displayed menu. Click on the desired place to enter the first polyline
vertex. Enter other polyline vertexes by clicking the left mouse button. Complete inserting
the polyline by using the right mouse button. The polyline will not close and its length will
be measured.

Activate the measurement from Measurements → Object count menu or click icon.
Place the mouse cursor on each object to be counted and click the left mouse button. The
objects will be marked by the cross and in the Table of measured values, their number will

be displayed. Finish the counting by clicking the right mouse button or by clicking the
icon or by [Esc] key. After reactivating Object count function, in the same image the next
objects to be counted will be marked with a cross of a different colour and the number of

another group of objects will display in the Table of measured values. Press
button in the Table of measured values to continue counting the group of objects highlighted
in the table.

1. highlight the group of objects by clicking on the corresponding row in the Table of
measured values

2.
press the button

3. continue with counting of objects
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If you want to change the colour or size of the crosses of the group of counted objects,
choose appropriate group in the Table of measured values and choose required parameters

using the icon.

Measurement of angles

Activate the measurement of angles from Measurements → Angles menu or click icon
and select the type of measurement. In Measure arbitrary angle mode, click and drag the
mouse to draw the first arm or define arm by clicking the starting and final point. Release
the mouse button and click to insert the final point of the second arm. The angle between
the arms will be measured – smaller than 180°. If you want to measure the complementary
angle, move the label with the measured value displayed in the image using your mouse
to the opposite side respectively to the vertex of the angle. In Measure angle from X axis
or Measure angle from Y axis modes, click and drag the mouse to define the first arm and
release the mouse button to insert the corresponding axis. When measuring the Angle
between two line segments, insert the first line segment by clicking and dragging the mouse.
Release the mouse button and click and drag the mouse again to insert the second line
segment. A convex angle (up to 180 degrees) will be calculated.

Measurement of a distance between parallel lines

Activate the measurement of distance between parallel lines fromMeasurements→Distance

between parallel lines menu or click icon. Click and drag the mouse to insert the first
line segment into the image. Then relocate the mouse cursor to the place where you wish
to insert the second line segment and click to insert.

Measurement using arc tool

Activate the measurement from menu Measurements → Arc menu or click icon. Then
click three times in the image on points to be intersected by the arc. The first and the third
point are the outer points of the arc. Length, radius and angle of the arc can be measured.

4.4. Display of a Grid with Defined Dimensions

Two grid types with defined dimensions are available.

• orthogonal grid
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• circular grid

Display of an orthogonal grid

Activate the orthogonal grid from View → Show orthogonal grid menu or click icon.
In the dialog box that appears, enter the grid dimensions in μm, mm or in pixels. The
calibration needs to be assigned to the current image in order to define the dimensions in
μm, mm. To select the grid colour, press the Change button and select the desired colour.
The coloured rectangle is used as an indicator of the currently set colour. Press the OK
button to display the grid. The grid may be moved in any direction by clicking and dragging

the cross in the grid centre. Click icon again to hide the grid. The grid default settings
can be set in the Settings menu, see “Grid“ on page 107.

Display of a circular grid

Activate the circular grid from View → Show circular grid menu or click icon. In the
dialog box that appears, enter the spacing between circles in μm, mm or in pixels. The
calibration needs to be assigned to the current image in order to define the dimensions in
μm, mm.To select the grid colour, press the Change button and select the desired colour.
The coloured rectangle is used as an indicator of the currently set colour. Press the OK
button to display the grid. The grid may be moved in any direction by clicking and dragging
the cross in the grid centre.

The grid default settings can be set in the Settings menu, see “Grid“ on page 107.
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Note

The displayed grids will not be saved in the images.

4.5. Phase Analysis

Phase analysis function allows to measure the percentage content of a certain colour or
grey level (phase) in the image. Up to four phases can be measured in one image. Activate

Phase analysis function from, Measurements → Phase analysis menu or click icon.
On the right-hand side of the screen, the phase analysis control panel appears.

Note

You can convert the colour image to grey scale using the function from Image
→ Grey scale menu.

Measurement procedure

1. Selection of an image intended for the measurement

Open an image in which you want to measure the phases in the View window. If you have
a display of 2 or 4 images activated, click to the applicable image using your mouse to
make it active. It will be framed in blue.
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2. Activation of the phase analysis function

Activate the Phase analysis function from Measurements → Phase analysis menu or click

icon.

3. Selection of an active phase

In Active phase selection part of the window select the phase number you want to measure.
If it is the measurement of the first phase in the current image, leave first phase active. If
you have already measured a phase in the image and want to measure the next one, select
another, e.g. the second phase. The controls in Active phase control part are always active
for the phase selected in Active phase selection part.

4. Measurement of a phase

After you have selected the active phase, you can start the measurement. Use the mouse
cursor to mark the colour or grey level which percentage rate you want to measure. The
cursor changes to a cross. If the cursor is an arrow, the image is not active. In that case
click into the image and the cursor will change to a cross. For more accurate selection of
the required place in the image, the vicinity of the current cursor placement is displayed
zoomed in the lower part of the Phase analysis control panel. Click with the left mouse
button to perform the measurement. The measured colour or grey level will be replaced
with a colour set in Active phase control part. If you want to use a colour other than the
default one, click the coloured rectangle next to Colour label in Active phase control part
and select the colour you require.

76

Main Window of the Application



Use the slider under the Threshold label to set the threshold level.
To fine tune the setting, you can use the field with the numerical
value next to the slider. The current phase will be recalculated
immediately after the threshold change. If you want to add
another e.g. colour distinctive area of the active phase to the
selected area, make sure the Add area button is pressed and click
to the desired spot of the image to add the required area. This
area will also be replaced by the colour of the current phase and
as a result, a summary of both the areas will display.

If you want to remove an area from the active phase, you can
either reduce the threshold level or activate the Remove area
button and click to the image to remove the required area from
the active phase. If you deactivate the Show phase button, no
phases will be displayed in the image. Press the button again to
display the phases.

Press the Inversion button to invert the selection.

5. Setting up the shared areas

In the lower part of the panel, you can choose whether phases
may have shared areas (intersections) or not. If you selectWithout
shared areas, an area already included in a phase cannot be
calculated to another one. If you select Shared areas of colour,
any image area can be included in any number of phases. The common areas will be
indicated in the image by a colour identical to that of the rectangle next to the Shared areas
of colour option. Click the rectangle to select the colour of the shared areas.

6. Counting mode selection

In Counting mode part you can select whether the percentage representation of a certain
phase will be calculated with respect to the whole image or the other phase's representation
only.

The measured values are displayed in Active phase part as well as in the Table of measured
values.
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4.6. Hardness Measurement

Customary method for hardness measurement is measurement of the imprint size caused
by a body with a specific shape which acts at a certain power for a certain time.
QuickPHOTO Industrial 2.3 enables the measurement of material hardness using the Brinell
(according to EN ISO 6506-1 standard) and Vickers methods (according to EN ISO 4516).

The measurement based on Brinell consists of imprinting a ball of a given diameter into
the material surface. The imprint can be captured using a microscope or a hardness tester
and measured using the Measure Brinell hardness function. After entering the values of
acting load and time, the material hardness will be calculated.

The measurement based on Vickers uses a regular square-based pyramid with a given
vertex angle between the opposite walls to make the imprint. After capturing the imprint
using a microscope, the Measure Vickers hardness function can be used to measure the
diagonals and after entering the values of acting load and time, the material hardness will
be calculated.

Brinell hardness measurement

1. Insert a specimen with the imprint created by the Brinell method under the microscope

or the hardness tester and click icon to display the control panel of the imaging
device.

2. Focus the microscope or a hardness tester on the specimen surface.
3. Capture the image.
4. In the Main window of the program assign the magnification to the image with which

it was created.
5.

Click icon. The mouse cursor changes to line segment. Press the left mouse button
to place it exactly on the imprint edge (see figure). Then locate the second line segment
on the opposite imprint side. Identically place two more line segments perpendicularly
to the previous ones. After inserting the last one, a measuring square will overlay the
line segments. If necessary, use the green squares to adjust the frame to encompass
the imprint.
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6. Brinell measurement window appears where the actual size of the imprint diameter
is displayed. Use the drop-downMeasure typemenu to select the corresponding option
by the type of ball used. Use Diameter of ball menu to select the corresponding size
and from Mass menu, select the value of the load in kilograms. Enter time in the Time
text field. The Result field will display the calculated material hardness. If the field
is red, it means the deviation of the measured diameter from the diameter of the ball
used exceeds the tolerance specified by EN ISO 6506-1 and the measurement is
invalid.

Note

The Diameter of ball drop-down menu and the Mass drop-down menu contain
only items specified by EN ISO 6506-1. If you want to use custom values type
them into the respective fields.

Press the OK button to complete the measurement and the measured value will display in
Table of measured values.

You can double-click on the inserted object to bring up a dialog for editing the measurement
parameters.
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Vickers micro-hardness measurement

1. Insert a specimen with the imprint created by the Vickers method under the microscope

and click icon to display the control panel of the imaging device.
2. Focus the microscope on the specimen surface.
3. Capture the image.
4. In the Main window of the program assign the magnification to the image with which

it was created.
5.

Click icon. The mouse cursor changes to a cross. Press the left mouse button to
place the cross exactly on one of the vertexes of the square imprint (see figure). Then,
place crosses on the remaining vertexes. After all four crosses have been placed, a
measuring square will overlay the crosses. If necessary, use the green squares to adjust
the frame to encompass the imprint.

80

Main Window of the Application



6. Vickers dialog box appears where there will be the sizes of both the imprint diagonals
and the deviation of their difference with respect to the longer diagonal. From the
Mass drop-down menu, select the value of the load in kilograms. Enter time in the
Time text field. The Result (HV) field will display the calculated material hardness.
If the field is red, it means the deviation of the diagonals exceeds the tolerance specified
by EN ISO 4516 and the measurement is invalid.

Note

The Mass drop-down menu contains only items specified by EN ISO 4516. If
you want to use custom values type them into the Mass field.

Press the OK button to complete the measurement and the measured value will display in
Table of measured values.

You can double-click on the inserted object bring up a dialog for editing the measurement
parameters.
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4.7. Handling Measuring Objects

Changing the size and position of the measuring object

In case you do not have any other tool active, the Select tool is automatically active.
This tool allows any object to be selected and modified. Select the object by clicking on
its boundary or measured value with the left mouse button. The object will be framed or
dashed with green line with grasping points. To handle more measuring objects at once,
hold the [Shift] key and click to highlight all objects you want to change. To cancel the
selection, click anywhere else in the image or select another object.

If you want to move the object, place the cursor over it. The cursor changes to . Drag
your mouse while pressing the left button to move the object. If you want to change the
size of the measuring object, move the cursor over one of the grasping points. The cursor
changes to . Drag your mouse while pressing the left button to change the size of the
measuring object. In case of an ellipse, you can also change its orientation. Move the cursor
over the central grasping point of the ellipse, drag your mouse while pressing the left button
to freely rotate the ellipse. After modifying the measuring object, the measured values will
be recalculated automatically.
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Changing colour and thickness of the line of measuring objects

Select the object with tool to change its colour by clicking left-hand part of the
icon and selecting the new colour. Click the right-hand part to select the thickness of the
line of the measuring object.

Deleting the measuring object

Select the measuring object with tool. Delete the selected object using icon or by
pressing the Delete button. If you want to delete all inserted objects (drawings,
measurements as well as text labels), select the Edit → Clear all inserted objects option

or click icon.

Changing the position of a label with measured value

Select the measuring object with tool. Then move the cursor over the label with the

measured value displayed in the image. The cursor changes to . Now, you can click
and drag the value to move it where you need. The type of auxiliary line changes
automatically depending on the current value position with respect to the position of the
measuring object.

4.8. Work with Table of Measured Values

The measured values are displayed in a tabular table with a number of tabs conforming to
the number of displayed images and the Measurement settings - Image... tab at the bottom
of the View window. Each tab contains values measured in one of (up to four) images
displayed in the View window.

Using the last tab Measurement settings - Image... the measurement parameters can be
adjusted for the current image and if necessary, the calibration assigned to that image can
be changed.
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The measured values from other opened images (opened in Thumbnails panel) can be
displayed by displaying the image in the View window.

Image tab

Using the ( ) buttons in the bottom
part of the Image X tab you can filter the measured values to be displayed. The other values

will stay hidden. Using button you can display all measured values. You can navigate
through the table by scrollbars in the right-hand part of the table, by mouse wheel or by
[Page Up] and [Page Down] keys. If you select a measured value in the table the
correspondent object will be highlighted in the image. If measured values of the same type
are displayed the basic statistics will display in the right-hand part of the table.

Note

When displaying values by button the measured values by Brinell and
Vickers hardness will not be listed. If you want to see the these values press the

button.

Saving measured values

The measured values can be saved in XLS file format for further processing in Microsoft®

Excel program or in the form of a text file for export to another spreadsheet processor (the
values are separated by a tabulator).
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To save the measured values, press the button in the bottom part of Table of measured
values or select Save measured values... option from the File menu. Select the location
and file name. In Save as drop-down menu, select the file format. You can choose from
XLS (Microsoft® Excel) or TXT – a plain text file. To save in XLS format, Microsoft®

Excel program must be installed on the computer.

If the image with measurements is saved as JPEG or TIFF file without previous merge of
objects with the image (by Edit → Flatten image function), the measured values will be
stored in the image file as well. The measured values will be displayed when the image
will be opened in QuickPHOTO Industrial, MICRO, CAMERA or ENDO program again.

Inserting notes

You can use the Description column to write a short comment for each measured value.
Select the cell used for entering the note with the mouse, enter the text and confirm by
pressing [Enter]. To edit an already written comment, select the cell and press the left
mouse button or [F2] key.

Hiding the table of the measured values

To get more space for work, you can press the button to hide the Table of measured

values without deleting its contents. Display the table again by clicking icon in the
Tool bar or from View → Show table of measured values menu.

Releasing and anchoring the table of measured values

For better transparency, the Table of measured values can be displayed in a separate window

by pressing the button. Use the button to return the table to its original position.

Measurement Setting – Image… tab

The tab always conforms to the current image in the View window. Here, you can define
which measured quantities should be calculated in the current image and define a custom
prefix for each quantity. The changes are reflected only in the current image, the other
images opened in Thumbnail panel remain unchanged. Furthermore, you can set the font
size of a scale bar and measured values, show or hide number of measurement and set the

85

Main Window of the Application



colour and thickness of auxiliary lines.Change image calibration button opensCalibration
change window where you can change the calibration and magnification assigned to the
image. In the Calibration change window you can also find Delete calibration button that
removes the calibration assigned to the current image.

5. Creating Reports
QuickPHOTO Industrial 2.3 enables an easy creation of measurement reports in Microsoft®

Word format. The wizard for creating the templates, the template manager as well as the
templates made can be found in the Reports menu.

Important

When using Reports function, the application checks correct installation of
Microsoft® Word, version XP or higher. You cannot use Reports if you do not
have Microsoft® Word installed. The sample files you can use for creating your
own reports are available in the ...\QuickPHOTO Industrial 2.3\Reports folder.

1. Creating a sample for the template

First, prepare a Microsoft® Word document from which a template for the reports will be
created.
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The template for creating reports will be created based on the placement of images, texts
and tables in this document. The properties of the objects:

• texts: texts contained in the sample will be retained in the resulting report
• images: the sample document may contain two image types:

○ images that remain unchanged in the resulting report (e.g. logos)
○ images used for placement and sizing of images to be inserted by QuickPHOTO

Industrial 2.3 into the report
• tables: the sample document may contain two types of tables:

○ tables that remain unchanged in the resulting report
○ tables used for the placement of tables with measured values

Save the sample file as a normal Microsoft® Word file. Based on this document, the report
template will be created.
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Note

For individual objects, the text should flow around as "square" or "in line with
text".

2. Creating templates

Activate Template wizard from menu Reports → Create template.

Press Next button to open the dialog where you can select the Microsoft® Word document
file created according to the procedure above (field marked with 1) that will become a base
for creating the template. Template wizard uses the text and file arrangement of this
document, e.g. images inserted in this document may be replaced by images, however the
texts will stay (including the font types used), as will the footnote and heading. The tables
inserted into the document may be replaced by tables with values measured in the
corresponding images. Enter the name of the new report template (field marked with 2).
The maximum template name length is 30 characters and must consist of letters without
diacritics, dashes and underscores. This name will be listed under Reports menu.

Press Next button to process the images. All images will be successively loaded from the
document and you will be prompted to decide whether the image contained in the resulting
report is retained without change or replaced by an image from QuickPHOTO Industrial
2.3. Select No, this image is a fixed part of the report to retain the image in the report
without changes. This is suitable e.g. for logos.

If you check Yes, the original image will be replaced by an image from QuickPHOTO
Industrial 2.3 when creating the report. The image size selection option is offered as well.
Check Equal to the size of the image in the opened document to adapt the width of the
inserted image to the width of the original image. CheckCustom size to set the image width
manually. In both cases, the height will be proportionally calculated to avoid distortion.
Continue by pressing Next button and in a similar way, all other images in the document
will be processed.
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After processing all the images contained in the document, the tables in the document will
be processed as well. If the application finds a table in the original document, you will be
prompted to decide whether the table will be retained unmodified in the resulting report
or whether the Table of measured values will be inserted for the selected image instead.
In the lower part of the dialog, you can set the quantities and columns the table will contain
in the report.

In Select measure quantities shown in the report, you can check which types of measuring
quantities are to be displayed in the table in the report. For example, if you uncheck Angles,
the measured values of angles will not be displayed in the table as measured in the image.
In the lower part of the dialog, there is a table preview to be inserted into the report. Set
the table parameters, press Next button and continue setting the other tables similarly.
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After completing the table settings, check the displayed data and then press Finish button
to save the template.

The saved templates will be available in the Reports
menu.
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3. Template manager

Template manager window is intended for
deleting and renaming existing templates.

• Activate the manager from menu Reports→
Template manager....

• Select the template and clickDelete to erase.
Attention, no undo is available.

• Select the template and click on Rename to
change the name of template. The maximum
template name length is 30 characters and
must consist of letters without diacritics,
dashes and underscores.

• Close the Template manager window by
clicking Close. The changes are saved
automatically.

4. Creating reports

To create a report, proceed as follows:

1. In the Thumbnail panel, select the images you want to export to the report.

2. Select a template from Reports to base the report on. You will be asked to set the
quality of the inserted images. The setting can depend on the required report print
quality.
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The lower the quality you set is, the smaller the data report file will be. Therefore, we
recommend using high quality only when you require high print quality of the report.

Warning

In case of inserting several images into the report and setting high quality, the
resulting file may take up to several tens of megabytes.

Press Continue button to start exporting. If you select more images than it is allowed for
the template, a reduced number of images will be inserted (the first selected images). The
file processing time depends on the number and quality of inserted images and the
performance of your computer. During the report exporting progress is indicated in the
lower part of the screen and work with QuickPHOTO Industrial 2.3 is not possible. Finally,
you will be prompted to enter the report name and its location. After the report is completed,
you will be offered to open the report in Microsoft® Word. The resulting report may be
edited in Microsoft® Word.

If you use the template displayed at the beginning of this chapter, the resulting report may
look like this:
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6. Additional Features
Image information on the actual image can be displayed using Image information function.
A slide show from opened images can be performed using a Presentation mode function.
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6.1. Image Information

In the View menu there is located the Image information option. It opens a dialog with

three tabs (Image, Meta data and Calibration). The function can also be activated by
icon in the Tool bar.

1. Image tab

This tab displays information on the image (folder where the image is stored, file
name, size, dimensions in pixels and dimensions in mm or μm).

2. Meta data tab

The tab displays meta data of the image if available. Some imaging devices only add
the meta data into the images (e.g. OLYMPUS® consumer cameras, DP20).

3. Calibration tab

This tab displays information about calibration contained in the image (name of the
calibration, magnification and width of pixel in μm).
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6.2. Presentation Mode

Presentation mode function automatically displays all images opened in the Thumbnail
panel or images contained in the selection (blue framed) in Thumbnail panel. To make an
uninterrupted selection, mark the first image and then mark the last image while holding
the Shift key down. An interrupted selection can be made by marking the previews while
the Ctrl button is depressed. The Presentation mode can be activated from menu View →
Presentation mode or by the Alt+S shortcut. In the presentation mode, one can control the
presentation by using [Page Up] (back to the previous image and stop presentation), [Page
Down] (next image and stop presentation) and [Space] (run stopped presentation).

The settings for Presentation mode can be reached from menu Edit → Settings in
Presentation mode part. In the dialog box that appears, you can set the delay between
images. If you check Close when finished, the Presentation mode will be terminated after
displaying the last image. Confirm by clicking OK.
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7. Settings
In the Edit menu there is a Settings... option that opens a dialog box with two sections. The
first section contains options for the general application settings and the second one the
settings of the measuring functions.

The settings can be saved onto a hard drive and if necessary, loaded again. To save, press
Backup settings button and select where the settings should be saved. Press Load settings
button to reload the settings again if necessary. This method backs up and restores the
application settings.

7.1. General Section

OLYMPUS® cameras

This tab is available only ifOLYMPUS® consumer digital camera orOLYMPUS®E-System
SLR camera support has been installed. It can be used for setting a device for displaying
a live image from OLYMPUS® digital cameras. If you have the live image displaying
device supplied with the software installed it is configured automatically when the tab is
activated. If the device is not configured automatically select the appropriate device from
the Capture device drop-down menu and the input video signal standard from Video

96

Main Window of the Application



standard drop-down menu. In the Input menu the appropriate input can be selected. The
Composite option should be checked. To return to the original settings, press the Restore
button. The Open... button in Advanced settings part opens a dialog window for manual
setting of the device for displaying the live image (for advanced users only). Check Keep
image on memory card to retain the image on the memory card after transferring to the PC
(only for CAMEDIA® and SP series). Uncheck to delete the image from the memory card
after transferring to the PC. The recommended setting is - unchecked.

Analog video source

This tab is available only if Analog video Source support has been installed. It can be used
for choosing a device for displaying a live image from analog video sources. If you are
using a device supplied with the software it will be configured automatically when the tab
is activated. If the device is not configured automatically select the appropriate device
from the Capture device drop-down menu and the input video signal standard from Video
standard drop-down menu. In the Input menu the appropriate input can be selected. To
return to the original settings, press the Restore button. The Open... button in Advanced
settings part opens a dialog window for manual setting of the device for displaying the live
image (for advanced users only).
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Control panels

In this tab you can set some properties of the camera control panels.

If you check Minimize control panel after capturing option the control panel will be
minimized immediately after every capture action.

Display control panel on the second monitor can be used only when two monitors are
attached to one computer. One displays the Main window and the other the control panel
of the imaging device.

If you check Run control panel after program startup, the control panel of the active
imaging device will be activated automatically after program start up.

These settings apply to all control panels of all imaging devices.
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Image numbering

In this tab there can be set the mode of numbering and naming of newly captured images:

• Numbering of captured images: the captured images can be numbered from 0001 every
time the program starts or the continuous numbering can be set. When continuous mode
is set the number can be reset to 0 by Reset count button.

• Names of new images: by default newly captured images are named with P letter and
an ordinal number (e.g. P0001) and new images captured by Timer module by T letter
and an ordinal number. If you want to assign a different letter or name for new images
you can type it to the appropriate fields.

The setting takes effect after the program restart.
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External trigger

This page is intended for setting and verifying the external trigger function. External trigger
is an optional accessory that can be connected via the serial or USB interface. If you have
the external trigger and want to use it, check the Use external trigger option and select the
COM port (a virtual COM port in case of USB trigger) which it is connected to.

In the Trigger type part choose the appropriate type of the trigger. The trigger with two
buttons is intended for capturing images and video recording using RECORD IT module.

Check the functionality of the trigger by pressing its button/s. If, when pressing the button/s,
the square/s change/s colour to green and then back to black after release, the external
trigger is connected correctly and is ready for use.
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Update

This tab is intended for setting the automatic Internet update. The program can search for
updates daily, weekly or monthly. If you do not want to search for updates or if you are
not connected to Internet, do not check Enable autoupdate from Internet option. It is
recommended to keep the function active.
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Presentation mode

This tab is intended for setting the delay between the images displayed in Presentation
mode. If you check Close when finished option, the Presentation mode will be terminated
after displaying the last image.

Default folders

This section allows setting folders to be opened as default when saving images, measured
values and reports. It eliminates the necessity of going through the complete folder structure
to select the folders where the images, measured values or reports should be saved.
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Language

In this tab, you can choose the language version of the program. Choose the desired version
and click the Change language button. Restart of QuickPHOTO Industrial 2.3 is needed
after changing.

103

Main Window of the Application



7.2. Measurements Section

Units

This tab allows you to select the units used for displaying the measured values. You can
select either mm or μm. The number of decimal places can be set as well. As for angles,
you can select the format for displaying the values.

Important

When using level of accuracy in tenths of µm you can reach relevant results only
when using specific magnifications.

Scales bars

Using this tab you can define your own type, shape and appearance of the calibred scale
bar. In the Scale bar type part, you can choose a type of the scale bar: Bar, Line, Staple.
In the Scale bar size part, you can select one of two automatic sizes of the scale bar (Small,
Large) or you can select the Custom size option and specify a custom size of the scale par
in the Desired size field. The Preview part shows how the scale bar will look like with
current setting. A colour of the scale bar and text of its value bellow the bar can be set in
the Scale bar and font colour part. To change the colour double click the coloured square

104

Main Window of the Application



or press the Change button. In the Background part, you can select an area and a colour
of scale bar background. When you select theValue option, the background will be displayed
only under the value of the length of the bar. When you select the Value and scale bar
option, the background will be displayed under the whole scale bar object. To change the
background colour double click the coloured square or press Change.

This is useful when you want to achieve better visibility of the scale bar in the image. User
defined scale bar settings can be stored in one of four predefined profiles. Proceed as
follows: perform all settings and then press the Save button in the Profiles part. From the
Save settings into profile drop-down menu select one of four profiles that will be overwrite
with new settings. Then enter a new name of this profile into the Enter new name of the
profile field. Finish by pressing the OK button.

Colours/Sizes

This tab is intended for setting the colour and size of the measured values font and for
setting the colour and thickness of auxiliary lines. All the settings will be used as default
for all newly captured or opened images. This settings can be adjusted for each image
using the items in the Table of measured values in Measurement settings - Image... tab.

Auxiliary lines settings - the auxiliary line is the line that connects the measured value in
the image with the corresponding measuring object in case the value is moved.
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• Colour of auxiliary lines: to change the colour of auxiliary lines double-click on the
coloured rectangle or press the Change button next to it. Then select the desired colour.

• Thickness of auxiliary lines: the desired thickness can be selected from the drop-down
menu.

Colour of measured values in the image: for better transparency, each measured value
in the image and the corresponding one in the Table of measured values is displayed in
the same colour. Two possibilities of assigning colours are available:

• If Repeat colours in order option is selected the colours will be assigned in predefined
order. After the last colour is assigned the assigning will start again from the first one.
The order of colours can be set using the list with 10 coloured stripes. If you want to
change the colour of one of the stripes, double-click on it or select it and press Change
button. Then select the desired colour.

• If Custom colour option is selected all the measured values will be displayed in a user
defined colour. The coloured rectangle indicates the selected colour. Double-click on
the rectangle or press the Change button next to it to change the colour.

Font of measured values and the scale bar in the image option allows the default font size
for displaying the measured values and the scale bar in the image to be set.
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Grid

This tab is intended for setting the default dimensions of a rectangular (X-horizontal and
Y-vertical span) and a circular grid (spacing).

Measured quantities

This tab is intended for setting the quantities whose values will be displayed by the
measuring object in the image (length, diameter, radius, perimeter, area, angle) and setting
the letters to the quantities (Prefixes). The quantities to be displayed should be selected by
checking the corresponding check boxes. To change the prefixes, rewrite the letter in the
relevant column. When Yes is selected in Show measure numbers in the image menu, the
corresponding sequential number will be displayed for each measured value. These settings
will be default for the program and for all new images.
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Hardness

This last tab is intended for defining the default values for the hardness measurement. You
can set the time in seconds (for both the Vickers and Brinell methods) and diameter of the
ball used in millimetres (in case of the Brinell method).
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Control Panels of Imaging Devices
The QuickPHOTO Industrial 2.3 is able to capture images from several types of imaging
devices. These devices can be controlled via dedicated control panels.

1. OLYMPUS® E-System Digital SLR Cameras

The control panel is intended for displaying a live image, controlling the camera functions
and capturing images from OLYMPUS® E-System SLR cameras. The controls are located
in seven tabs. Size of control panel can be changed using mouse. Settings will be used
even for the next launch.

109



Important

Control panel of OLYMPUS® E-330 camera is not equipped with several functions
described below. The E-330 camera can be controlled only from the account with
administrator privileges in Microsoft® Windows® 2000/XP operating systems.
This camera can not be controlled from the Microsoft® Windows® Vista operating
system.

Capture tab

The tab contains the controls for setting the camera parameters, setting the exposure and
capturing images.

Capture: takes an image and transfers it to the computer. You can also use
the [Ctrl + Enter] shortcut.

Full screen: the button is used for displaying the live image full screen. In
this mode, you can control the application using the Capture and Exit full
screen mode buttons in the upper part of the live image.

Connect: the button is enabled only when the camera is not correctly
connected. Press the button to re-establish communication.

Quality: the image quality can be selected in this menu. For some quality options
the image resolution can be selected in the Resolution drop-down menu.
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Program: this drop-down menu controls the exposure modes. TheManual
option: aperture and shutter speed can be set manually from Shutter speed
and Aperture drop-down menus. This option is available only when the
lens is attached to the camera body. The Auto option: exposure parameters
(aperture and shutter speed) are calculated automatically by the camera.

The exposition can be "frozen" by pressingAEL (Auto Exposure Lock) button. TheAperture
priority option: the aperture value can be selected from the drop-down menu and the shutter
speed is calculated automatically. This option is available only when the lens is attached
to the camera body. The Shutter priority option: the shutter speed can be selected and the
aperture is evaluated.

Metering mode: here one can select one of several exposure metering
modes. See the user's guide of the camera for more details.

Resolution: for some quality options, the image resolution can be selected.

Sequence: the number of images to be captured in the sequence after the press
of Capture button can be selected.

Sensitivity (ISO speed): sets sensitivity of the sensor. The levels conform to
the sensitivity of traditional photo materials in the ISO scale. When Auto is
selected, the camera changes the sensitivity automatically depending on the
actual light conditions.

Shutter speed: when capturing in the Manual or Shutter priority mode, here
one can set the required shutter speed.

Aperture:when capturing with attached lens in theManual or Aperture priority
mode, here one can set the required aperture.
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White balance: this option is used for setting the white balance for various
kinds of illumination.

Anti-Shock time: a delay between opening the mirror and image capture
can be set to avoid capture of unsharp images caused by vibrations.

Exposure compensation: this option allows to brighten or darken the
image when the automatic exposure is set.

Warning

When the battery state indicator in the right upper corner of the tab changes its
colour to red, replace the battery as soon as possible. Low battery can cause
unpredictable behavior of the camera.

Macro tab

This tab is visible only when a lens is attached (the camera is not used for capturing from
a microscope).
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Auxiliary light: auxiliary light helps the camera to focus correctly in
dark conditions.

Flash bias compensation: it is possible to amplify or suppress the flash
intensity by selecting required value.

Flash mode: one can switch between flash modes. See the
user's guide of the camera for more details.

Focus metering mode: the area which will be used for
evaluating the focus can be selected. When using E-330
camera, this menu is accessible only if there is the A mode
selected in the Live view mode menu. See the user's guide
of the camera for more details.

Live view mode (E-330 only): the camera is equipped with two sensors.
In the B mode, the same sensor is used for capturing and also for
displaying the live image (sensor with higher resolution) but automatic
focusing is not available due to construction of the camera.

Colours tab

On this tab, one can set several functions influencing the quality of images.
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Colour mode: here, one can select from colour effects. Changes will
reflect in the live image. The default setting is VIVID.

Contrast: contrast of images can be adjusted via this menu.

Shading mode: shading correction mode can be activated via this menu.
See the user's guide of the camera for more details.

Sharpness: a sharpness enhancement can be set in this menu.

Gradation: a colour gradation mode can be selected in this menu.
Changes will reflect only in the captured image.

Saturation: a value of colour saturation can be set in this menu.

Live image tab

This tab contains the controls intended for setting the live image. The available parameters
are: brightness, contrast, saturation, hue, borders. These settings do not influence the
captured image but the live image only.
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Using the sliders, you can set the properties of the live image. The recommended procedure
is:

1. Capture the image and display it in View window.
2. Open the control panel of the OLYMPUS® E-System digital camera and activate the

Live image tab. Move the control panel to see the live image and the captured image
at once.

3. Using the sliders, set the live image parameters so that it is as similar as possible to
the captured image.

Using controls in the Crop borders part the unwanted borders of the live images can be
cropped.

Press the Default button to restore the default settings of the sliders.

Displayed area: this indicator shows actual dimensions of live image in
pixels.

Select: press this button to show dialog for interactive selection of borders
to be cropped from the live image.

Reset: press this button to show whole live image - crop of the borders will
be deactivated.

Restart live image: use this button in case the live image display fails, for
example after returning from the screen saver mode.

Setting up the borders to crop

After pressing the Select button there will appear a window with static image in which you
can select interactively the borders to be cropped. Select the area of the image you want

115

Control Panels of Imaging Devices



to keep displaying by the green rectangle. The rest will be cropped. Borders can also be
defined manually by the fields at the bottom of the window. Confirm by the OK button.
The settings will apply to the live image.

Shading correction tab

This tab contains controls of the shading correction function. One can use this function to
eliminate image distortion caused by inhomogeneous illumination (darker corners) or dust
on the camera sensor.
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Shading correction: enables or disables the shading correction function.

Illumination: choose Reflected or Transmitted option according to the
actual type of illumination. The used algorithm differs for each option.

Calibrationmask: after pressing theCapture mask button
a calibration mask will be captured. A thumbnail of the
mask will be displayed on the panel next to the button.

Correction level: using this slider one can set how strong
the correction should be.

Using the shading correction

To use the shading correction, it is necessary to capture a calibration image (mask). Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and adjust (shorten) the exposure time so you can observe the

inhomogeneity of illumination. The darkest areas shouldn't be black.
3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Illumination part select

Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed in the control panel.

5. Insert the specimen and set the exposure time.
6. In the Correction level part adjust the correction level by using the slider. Take an

image to check the accuracy of the settings. If necessary, adjust the slider position
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until you satisfied with the captured image. The shading correction will apply to all
further captured images.

Reflected light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Don't focus the microscope and

adjust (shorten) the exposure time so you can observe the inhomogeneity of
illumination. The darkest areas shouldn't be black.

3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Illumination part select

Reflected. Then press the Capture mask button. A thumbnail of the mask will be
displayed in the control panel.

5. Insert the specimen and set the exposure time.
6. In the Correction level part adjust the correction level by using the slider. Take an

image to check the accuracy of the settings. If necessary, adjust the slider position
until you satisfied with the captured image. The shading correction will apply to all
further captured images.

Important

The shading correction works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and further
images. After changing any setting it is necessary to capture a new calibration
mask.

In order to the correction would be successful the images have to be captured
with the same size (resolution) as the calibration mask. Otherwise the correction
will not be preformed.

Timestamp tab

The control panel is equipped with the function of insertion of the date and time of the
capture in the image - so called timestamp. The timestamp will become a solid part of the
image after the capture.
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Timestamp: enables or disables the inserting of the timestamp into the
image.

Settings: press this button to open the Timestamp settings dialog.

Insert: choose which information should be inserted in the captured
images.

Orientation: this field shows the actual orientation of the timestamp text in
image. To change the orientation double-click into this field or press the
Settings button. The Timestamp settings dialog will open.

Preview: this field shows the current
appearance of the timestamp reflecting all the
settings except the orientation. The text size is
the same as will be displayed in the image in
the zoom of 100% (1:1).

Position: the indicator shows the position
where the timestamp will be inserted to the
image.
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Timestamp setting dialog

After the press of the Settings button or double-click to theOrientation field the Timestamp
settings dialog will open.

Format: in this part the appearance of the timestamp can be adjusted.

Position: here there can be selected the corner in which the timestamp should be placed.

Orientation: the orientation of the timestamp text can be selected to best fit the selected
position in the image.

Profiles tab

All the settings of the control panel (except the Shading correction) can be saved to one
of four available profiles and loaded easily at any time.

120

Control Panels of Imaging Devices



Save to profile: after the press of this button a dialog for saving of
actual control panel parameters will open.

Default profile: after the press of this button all the control panel
parameters will be set to the default values. The saved profiles will
remain unchanged.

Saving settings to a profile

In order to save the control panel settings to a profile proceed as follows:

1. Set the required control panel parameters.
2. Press the Save to profile button in the Profiles tab. The following dialog will appear:

3. From the Available profiles section select the profile you want to save current control
panel settings to.

4. Type a new profile name to Profile name field.
5. Confirm by pressing the OK button.
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Loading of a profile

To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.

2. IDS uEye® Digital Cameras

The control panel is able to control several models of IDS uEye® cameras. The camera
type is recognized automatically during a start of the control panel. In case more than one
uEye® camera is connected to the computer, there will display a dialog box for selection
of desired camera upon launch of the control panel.

The controls are located in five tabs:
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Speed Adjustment

At the very first run, a performance test will be launched and the camera speed (FPS) will
be adjusted. This performance test is performed only once and will not be launched at next
run of the panel. If needed, the performance test can be launched manually by pressing
Speed adjustment button on the Settings tab.

Note

There should be no other application with high demand on CPU performance
running during the performance test otherwise the camera will work slower than
it could.

Image tab

The tab contains controls for camera settings, exposure settings and image capturing. All
camera settings effect the live image as well as captured images.

Capture: takes an image and transfers it to the computer. You can also use the
[Ctrl + Enter] shortcut or an external trigger if you have it.

Full screen: the button is used to display the live image in full screen mode.
In this mode, there are the Capture and Exit full screen mode buttons
available in the upper part of the live image.

Connect: the button is enabled only when the camera is not correctly
connected. Press this button to re-establish communication with the camera.

AutoWB: press the button to adjust the white balance. This function is suitable
mainly when the camera senses a white area.

123

Control Panels of Imaging Devices



Live image quality: here select the desired resolution of the live image.

Exposure mode: if set to Manual, the exposure time value is set by the
user. If set to Auto, the exposure time is automatically set depending
on the illumination of the field of view. When using the automatic

mode, an (Auto Exposure Lock) button is available. It “freezes”
the exposure time at the current value while taking the images.

Exposure time: click the arrows or drag the slider
to set the exposure time. The value can be also set
using the [+] and [-] keys on the numeric keypad

or the [Page Up] and [Page Down] keys.

Exposure correction: this option allows you to brighten or darken the image
when the automatic exposure is set.

Exposure region: here one can specify the region where the
illumination intensity is measured (when Auto exposure mode is
active). You can select one of the predefined sizes of the exposure
region (100% - the whole image, 30% and 1%). If you select the
30% or 1% option, a frame will display in the middle of the live
image showing the exposure region. The size and placement of the

frame can be modified by dragging or resizing with a mouse. By pressing theCenter button
the frame can be centered on the screen. By pressing the Show/hide button the frame can
be hidden or shown again. When hidden, the frame is still used to measure the exposure
but it is not visible. The frame can also be inserted directly: press the Custom button and
insert the frame by dragging the mouse while holding the left mouse button.

Note

When the frame of exposure region becomes red it means that the maximum auto
exposure time has been reached. In the automatic mode, the range of exposure
times is smaller than in the manual mode.
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Focus region: this tool helps to focus the microscope precisely. Proceed as
follows:

1. Roughly focus the specimen using the microscope focus knob. Press the Custom
button. Drag a frame into the live image by the mouse with left button pressed. If
needed, reshape or move the frame to the desired location.

2. There will appear a blue bar indicator of current focus with a red line denoting
maximum achieved sharpness value next to the frame. At the beginning, the current
focus value and the maximum value are the same. These values will also be displayed
as numbers in the frame caption in the form of current value / maximum achieved
value.

3. When turning the focus knob now, the blue bar will raise or decline respectively
according to increasing or decreasing level of focus. Choose the direction in which
the bar raises. Continue to turn the knob until the bar starts declining again. The red
line will remain fixed at the position of maximum focus. Gently turn the knob in
opposite direction to make the bar touch the red line - the focus value is maximum in
this position. The numbers can be used in the same way.

Note

The focus value is measured relatively. It means, that the bar shows whether focus
level increases or decreases in comparison with the initial value which is evaluated
after placing the frame in the image. If the focus level exceeds the range, the bar
is reinitialized to approximately 3/4 of its range. This doesn't mean that focus
decreased rapidly. If you continue turning the knob in the same direction and the
bar starts raising again, it means the focus level is still increasing.

The focus level measurement can be reinitialized by pressing the Reset button - the
maximum focus value will be set to the current value.

By using the Show/hide button, the frame can be hidden or shown again.
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Note

After moving the focus region, the measurement will be reinitialized (see the
Reset button).

Camera captures in: here one can select, if the images will be
captured in the resolution of the live image or in full camera
resolution. This option is active only when using certain types

of IDS uEye® cameras.

Cross: check the option to display a cross in the live image. The centre
of the cross is placed in the centre of the camera field of view. The centre
cross is not part of the captured images. The centre cross can be used

e.g. for measuring using the microscopic stage.

Colour mode: you can switch between Colour or Grey scale modes.

Settings tab

The tab contains the controls used for the manual setting of image parameters. The changes
are reflected in both the Live image and in the captured images.

Gain: the slider controls the signal power coming from the camera to the PC. Noise can
appear when higher gain values are set.

Brightness: the slider controls the brightness of the image.

Contrast: the slider controls the contrast of the image.

Black level: the slider controls the black colour level of the image.

Gamma: the slider sets the image gamma correction (balancing the brightness and contrast).
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Manual white balance: the sliders allow the intensity of
each of the three colour channels to be changed.

Edge enhance: the option enables the enhancing of sharp edges in the image.
Three levels are available: None, Weak and Strong enhancement.

Frame rate: shows how many frames per second camera actually displays.

Default: use this button to restore all settings on the Settings tab to default
values.

Speed adjustment: starts the performance test to adjust the camera speed
according to the computer performance.

Shading correction tab

This tab contains controls of the shading correction function. One can use this function to
eliminate image distortion caused by inhomogeneous illumination (darker corners) or dust
on the camera sensor.

Shading correction: enables or disables the shading correction function.
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Illumination: choose Reflected or Transmitted according to the actual
type of illumination. The used algorithm differs for each option.

Calibrationmask: after pressing theCapture mask button
a calibration mask will be captured. A thumbnail of the
mask will be displayed on the panel next to the button.

Correction level: using this slider one can set how strong
the correction should be. After pressing the Preview in
live image button one can observe the shading correction
effect in the live image.

Using the shading correction

To use the shading correction, it is necessary to capture a calibration image (mask). Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and adjust (shorten) the exposure time so you can observe the

inhomogeneity of illumination. The darkest areas shouldn't be black.
3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Illumination part select

Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

5. Insert the specimen and set the exposure time.
6. Press the Preview in the live image button in the Correction level part and adjust the

correction level by using the slider. The shading correction will apply to all further
captured images.

Reflected light
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1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Don't focus the microscope and

adjust (shorten) the exposure time so you can observe the inhomogeneity of
illumination. The darkest areas shouldn't be black.

3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Illumination part select

Reflected. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

5. Insert the specimen and set the exposure time.
6. Press the Preview in the live image button in the Correction level part and adjust the

correction level by using the slider. The shading correction will apply to all further
captured images.

Important

The shading correction works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and further
images. After changing any setting it is necessary to capture a new calibration
mask.

In order to the correction would be successful the images have to be captured
with the same size (resolution) as the calibration mask. Otherwise the correction
will not be preformed.

Timestamp tab

The control panel is equipped with the function of insertion of the date and time of the
capture in the image - so called timestamp. The timestamp will become a solid part of the
image after the capture.
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Timestamp: enables or disables the inserting of the timestamp into the
image.

Settings: press this button to open the Timestamp settings dialog.

Insert: choose which information should be inserted in the captured
images.

Orientation: this field shows the actual orientation of the timestamp text in
image. To change the orientation double-click into this field or press the
Settings button. The Timestamp settings dialog will open.

Preview: this field shows the current
appearance of the timestamp reflecting all the
settings except the orientation. The text size is
the same as will be displayed in the image in
the zoom of 100% (1:1).

Position: the indicator shows the position
where the timestamp will be inserted to the
image.

Timestamp setting dialog

After the press of the Settings button or double-click to theOrientation field the Timestamp
settings dialog will open.

130

Control Panels of Imaging Devices



Format: in this part the appearance of the timestamp can be adjusted.

Position: here there can be selected the corner in which the timestamp should be placed.

Orientation: the orientation of the timestamp text can be selected to best fit the selected
position in the image.

Profiles tab

All the settings of the control panel (except the Shading correction) can be saved to one
of four available profiles and loaded easily at any time.

Save to profile: after the press of this button a dialog for saving of
actual control panel parameters will open.
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Default profile: after the press of this button all the control panel
parameters will be set to the default values. The saved profiles will
remain unchanged.

Saving settings to a profile

In order to save the control panel settings to a profile proceed as follows:

1. Set the required control panel parameters.
2. Press the Save to profile button in the Profiles tab. The following dialog will appear:

3. From the Available profiles section select the profile you want to save current control
panel settings to.

4. Type a new profile name to Profile name field.
5. Confirm by pressing the OK button.

Loading of a profile

To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.
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3. Lumenera® INFINITY Digital Camera

Lumenera® INFINITY camera control panel is able to control several models of cameras
from Lumenera Corp. The camera type is recognized automatically during the start of the
control panel. If more than one Lumenera® INFINITY camera is connected to the computer,
there will display a dialog box for selection of desired camera prior to display of a control
panel.

Lumenera® INFINITY camera control panel is intended for control of camera functions,
display of a live view and still image acquisition. It consists of a tool bar, six tabs and a
live view.
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Note

A performance test will run when starting the control panel for the first time.
During the test there will be made several test snapshots which can be deleted
immediately after the end of the test.

Tool bar

The tool bar is located above the live view and contains several basic tools:

Connect: the button is enabled only when the camera is properly connected
to the computer, but the communication with the camera control panel is not
active. Press the button to reconnect the camera.

Cross: shows/hides the center cross

Default: sets the default orientation of the live view.

Rotate by 180°: rotates the live view by 180 degrees.

Mirror: mirrors the live view along vertical axis.

Flip: flips the live view along horizontal axis.

Grey scale: turns on/off the grey scale mode.
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Image tab

Capture: captures the snapshot and transfers it to the computer. You can also
use the [Ctrl + Enter] shortcut.

Full screen: the button is used to display the live image in full screen mode.
In this mode there are the Capture [Ctrl + Enter] a Exit full screen mode
[Esc] buttons available in the upper part of the live view.

Snapshot size: defines the resolution of the snapshot.
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Exposure mode: if set to Manual, the exposure time is set by user. If set
to Auto, the exposure time is automatically calculated depending on the
illumination of the field of view. SFL-Auto is an automatic mode for

fluorescence imaging. When using the Auto or SFL-Auto mode,
(Auto Exposure Lock) button is active. It “freezes” the exposure time at
the current value.

Exposure correction: this option adjusts the exposition when Auto or
SFL-Auto is set.

Exposure time: press the arrow buttons or drag the slider to
set the exposure time when set to Manual exposure mode.
The exposure time can be also set using the [+] and [-] keys
on the numeric keypad or the [Page Up] and [Page Down]
keys. Keyboard shortcuts can be also used during the work
with other tabs.

Exposure region: the size of the region used for automatic
exposure measurement can be set to 100%, 30% and 1% of
the live view area. If 30% or 1% option is selected a frame
will be displayed in the centre of the live view marking the
exposure region. The size and position of the exposure region
can be also user defined; press the Custom button and insert

the frame by dragging the mouse while holding the left mouse button pressed. The size
and position of the frame can be modified by mouse. By pressing the Center button the
frame can be placed back to the centre of the live view. By pressing the Show/hide button
the frame can be hidden or shown again. When hidden, the frame is still used to measure
the exposition.

Note

When the frame of exposure region turns red it indicates that the limit of automatic
exposure has been reached. In the automatic mode the range of exposure times
is smaller than in the manual mode.
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White balance: this function is intended for white color adjustment for
various illumination conditions. Press the Auto WB button to activate auto
white balance function using the whole live view area. After pressing the
Region WB button, the region used for automatic white balance function
can be user defined by dragging the region by mouse while pressing the
left mouse button. Use Default WB button to set the default white balance
settings. White balance can be also adjusted manually by theWhite balance
sliders in the Settings tab.

Focus region: this tool helps focusing the microscope precisely. Proceed
as follows:

1. Roughly focus the specimen using the microscope focus knob. Press the Custom
button. Drag a frame into the live image by the mouse with left button pressed. If
needed reshape or move the frame to the desired location.

2. There will appear a blue bar indicator of current focus with a red line denoting
maximum achieved sharpness value next to the frame. At the beginning, the current
focus value and the maximum value are equal. These values are also displayed as
numbers in the form of current value /maximum achieved value.

3. When turning the focus knob now, the blue bar will raise or decline respectively
according to increasing or decreasing level of focus. Choose the direction in which
the bar raises. Continue to turn the knob until the bar starts declining again. The red
line will remain fixed at the position of maximum focus value. Gently turn the knob
in opposite direction to make the bar touch the red line - the focus value is maximum
in this position. The numbers can be used in the same way.
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Note

The focus value is measured relatively. It means, that the bar shows whether focus
level increases or decreases in comparison with the initial value which is evaluated
after placing the frame in the live view. If the focus level exceeds the range, the
bar is reinitialized to approximately 3/4 of its range. This doesn't mean that focus
decreased rapidly. If you continue turning the knob in the same direction and the
bar starts raising again, it means the focus level is still increasing.

The focus level measurement can be reinitialized by pressing the Reset button - the
maximum focus value will be set to the current value.

By using the Show/hide button, the frame can be hidden or shown again.

Note

After moving the focus region, the measurement will be reinitialized (see the
Reset button).

Black balance: this function is used for setting the black
balance for fluorescence imaging. After pressing the Region
BB button, the region used for black balance can be user
defined by dragging the mouse with the left mouse button
pressed. Press Default BB button to set the default black
balance.
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Live view tab

Live view resolution: sets the desired resolution of the live view.

Frame rate: shows the speed of the live view in frames per second (FPS).

Image quality: Standard - high frame rate option - displays the fastest live view available
(maximum FPS), High - lower frame rate - displays the live view in the best available
quality with lower frame rate, Special - remove moire - use this option when unwanted
artifacts (e.g. stripes, dices) are visible in the live view.

Live view size: the live view can be displayed in the Original size (1:1) or can be resized
to Fit to window (a decrease of the live view speed may occur).

Performance test: press the button in case you want to repeat the performance test which
was performed during the first start of the control panel. The performance test determines
the minimal acquisition intervals your computer is capable to handle for time-lapse
capturing.
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Settings tab

Image settings:

Gain: the slider controls the signal strength coming from the camera to the PC. Noise can
appear when higher gain values are set.

Brightness: the slider controls the brightness of the image.

Contrast: the slider controls the contrast of the image.
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Gamma: the slider sets the image gamma correction.

Hue: the slider controls the color hue of the image.

Saturation: the slider controls the color saturation of the image.

Illumination compensation: color reproduction can be adjusted
according to the type of illumination used.

Restore default settings: restores the positions of all sliders in Image settings section
to their original values.

White balance: the white balance can be manually adjusted
using the R, G, B sliders (R-red, G-green, B-blue).

Restore default white balance settings: restores the positions of all sliders in White
balance section to their original values.

Black balance: the black balance can be manually adjusted
using the R, G, B sliders (R-red, G-green, B-blue). If the
camera is set to grey scale mode or the camera used is
monochromatic there is only one slider present.

Restore default black balance settings: restores the positions of all sliders in Black
balance section to their original values.
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Shading correction tab

This tab contains controls of the shading correction function. This function is designed to
eliminate illumination inhomogeneities (darker corners) or small scratches or dust on the
camera sensor.

Shading correction: enables or disables the shading correction function.

Illumination: select one of Reflected or Transmitted options according
to the current type of illumination.
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Calibration mask: press Capture mask button to acquire
the calibration mask from the camera. A thumbnail and
the resolution of the mask will display.

Correction level: press the Preview in live view button and use
the slider to interactively adjust the level of correction.

How to Use the Shading Correction Function

Important

The shading correction function works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and snapshots.
After change of any of the setting it is necessary to capture a new calibration
mask.

To use the shading correction it is necessary to capture a calibration mask first. Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and adjust (shorten) the exposure time so you can observe the

inhomogeneity of illumination. The darkest areas shouldn't be black just grey.
3. Press the Auto WB button (auto white balance).
4. On the Image tab set the snapshot resolution you want to use for capturing.
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5. Switch to the Shading correction tab and select Enabled. In Illumination part select
Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

6. Insert the specimen and set the exposure time.
7. Press the Preview in live view button in the Correction level part and adjust the

correction level by using the slider.

The shading correction will apply to all further captured snapshots until disabled.

Reflected light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Do not focus the microscope and

adjust (shorten) the exposure time so you can observe the inhomogeneity of
illumination. The darkest areas shouldn't be black just grey.

3. Press the Auto WB button (auto white balance).
4. On the Image tab set the snapshot resolution you want to use for capturing.
5. Switch to the Shading correction tab and select Enabled. In Illumination part select

Reflected. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

6. Insert the specimen and set the exposure time.
7. Press the Preview in live view button in the Correction level part and adjust the

correction level by using the slider.

The shading correction will apply to all further captured images until disabled.

Timestamp tab

The control panel is equipped with the function of insertion of the date and time of
acquisition into the snapshot- so called timestamp. The timestamp will become a solid part
of the image after the capture and cannot be removed.
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Timestamp: enables or disables the inserting of the timestamp into the
snapshots.

Insert: select what information should be inserted into the snapshots.

Orientation: this label shows the current orientation of the
timestamp text. To change the orientation double-click on
the label or press the Options button. The Timestamp
settings dialog will open.

Options: press this button to open the Timestamp settings dialog.

Timestamp setting dialog

After the press of theOptions button or double-click to theOrientation label the Timestamp
settings dialog will open.
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Format: in this part the appearance of the timestamp can be adjusted.

Position: selected in which position in the snapshots should be the timestamp inserted.

Orientation: select the orientation of the timestamp text by clicking on one of the labels.

Preview: this field shows the current appearance of the
timestamp reflecting all the above mentioned settings
except the orientation.

Profiles tab

All the settings of the control panel (except the Shading correction) can be saved to one
of four available profiles and loaded easily at any time.
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Profile: each of up to four stored profiles can be easily reloaded by pressing the
corresponding button.

Save to profile: set all the camera parameters first and then press
this button to store the settings to one of four available profiles.

Default profile: by pressing the button all the camera parameters
will be set to the default values. The saved profiles will remain
stored.

Saving Settings to a Profile

In order to save the control panel settings to a profile proceed as follows:

1. Set all the camera parameters.

2. Press the Save to profile button in the Profiles tab. The following dialog will appear:
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3. From the Available profiles section select the profile you want to save the current
settings to.

4. Type a new profile name to Profile name field.

5. Confirm by pressing the OK button.

Loading of a profile

To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.
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4. ARTRAY ARTCAM Digital Cameras

The control panel is able to control several types of ARTRAY ARTCAM cameras. The
controls are located in three tabs.

Image tab

The tab contains controls for setting the camera parameters, setting the exposure and
capturing images. All settings for the camera in the live image are reflected in the captured
images as well. Only the resolution is set separately for the live image and the captured
images.
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Capture: takes an image and transfers it to the computer. You can also use
the [Ctrl + Enter] shortcut or an external trigger if you have it.

Full screen: the button is used for displaying the live image full screen. In
this mode, you can control the application using the Capture and Exit full
screen mode buttons in the upper part of the live image.

Connect: the button is enabled only when the camera is not correctly
connected. Click the image to attempt to re-establish the communication.

Auto WB: click the button to automatically set the image colours most
naturally. This balance is suitable mainly when the camera senses a white
area.

Image quality: select the resolution in which the resulting image will
be taken. There are three options available.

Profile: the complete camera settings can be saved as one
of four profiles and reloaded and used again at any time.
To load a previously saved profile, select the profile name

from the list. If you want to store the present setting in the profile (and overwrite the old
profile), click Save, use Save as to select a profile to be overwritten and enter the name of
the profile in the New name text field. Finally, press OK button.

Exposure mode: if set to Manual, the exposure time value is set by the
user. If set to Auto, the exposure time is automatically set depending on
the illumination of the field of view. Furthermore, when using the

automatic mode, an (Auto Exposure Lock) button is available. It “freezes” the
exposure time at the current value while taking the images.

Note

Auto exposure mode is not available when the camera displays the live image at
the highest resolution.
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Exposure time: click the arrow or drag the
slider to set the exposure time from 1/1800
to 1.3 seconds. The value can be also set

using the [+] and [-] keys on the numeric keypad or the [Page Up] and [Page Down] keys.

Cross: check the option to display a cross in the live image.
The centre of the cross is placed in the centre of the field
of view. The centre cross is not part of the resulting image.

The centre cross can be used for measuring using the microscope stage.

Settings tab

The tab contains controls used for the manual setting of image parameters. The changes
are reflected in both the Live image and in the captured images (except for the resolution
settings).

Live image quality: select the resolution for displaying the live image
from the camera. The setting is not reflected in the resolution of the
captured images. When the highest resolution is set, theAuto exposure

mode will not be active.

Bayer mode: each of these options differently balances the RGB
colour levels.

Brightness: the slider controls the brightness of the live image.

Contrast: the slider controls the contrast of the live image.

Hue: the slider controls the colour hue of the live image.

Sharpness: the slider controls the sharpness of the live image.

Gain: the slider controls the signal power coming from the camera to the PC. Noise can
appear when higher gain values are set.
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Gamma: the slider sets the image gamma correction (balancing the brightness and contrast).

Manual white balance: used for manual adjusting of
white balance.

Saturation: the slider controls the colour saturation.

Default: use this button to restore all settings on the tab to default values.

Shading correction tab

This tab contains controls of the shading correction function. One can use this function to
eliminate image distortion caused by inhomogeneous illumination (darker corners) or dust
on the camera chip.

Shading correction: enables or disables the shading correction function.

Light type: choose Reflected or Transmitted according to the type of
illumination. The way of shading correction differs for each type.
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Calibrationmask: after pressing theCapture mask button
a calibration mask will be captured. A thumbnail of the
mask will be displayed on the panel next to the button.

Correction level: using this slider one can set how strong
the correction will be. After pressing the Preview in live
image button one can observe the shading correction
effect at the current setting and adjust the setting to
achieve the best result.

Using the shading correction

To use the shading correction, it is necessary to capture a calibration image (mask). Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and, in case of need, adjust (shorten) the exposure time so you

can observe the inhomogeneity of illumination. The darkest areas shouldn't be black.
3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Light type select

Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.

6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.

Reflected light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Don't focus the microscope and,

in case of need, adjust (shorten) the exposure time so you can observe the
inhomogeneity of illumination. The darkest areas shouldn't be black.
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3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Light type select Reflected.

Then press the Capture mask button. A thumbnail of the mask will be displayed on
the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.

6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.

Important

The shading correction works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and further
images. After changing any setting it is necessary to capture a new calibration
mask.
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5. OLYMPUS® DP72 Digital Camera

OLYMPUS® DP72 is a digital camera with the 2/3" CCD chip. The chip incorporates 1.45
million effective pixels, which can be piezo-shifted during image acquisition to obtain a
maximum effective resolution of 12.8 million pixels. Peltier cooling of the chip to
temperature 10°C lower than the temperature of environment, provides significant reduction
of noise level and high sensitivity. OLYMPUS® DP72 camera is suitable for fluorescence
microscopy where low signal intensity is present.

OLYMPUS® DP72 camera control panel is intended to control the camera functions, live
image displaying and image capturing. It consists of a tool bar, six tabs and the live image.
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Tool bar

The tool bar is located in the upper left corner upon live image. The tool bar contains tools
that modify the camera parameters and tools that modify the parameters of the live image.

Standard view: displays the live image in a standard mode (disables a zoomed).

Zoomed view: activate this tool and click in the live image to zoom the live image
by 100%. The zoom has no effect on the captured images. This button is inactive
when the resolution of the live image is set to 1360 x 1024.

Rotate by 180°: rotates the image by 180°

Flip vertically: flips the live image vertically

Flip horizontally: mirrors the live image horizontally

Colour/Gray scale mode: switches between colour and grey scale mode.

Focus region (bar graph , numbers ): this tool helps to focus the specimen. You
can select from bar graph or numbers display mode. The bar graph shows the current value
of the focus (in the graph represented by a blue bar) and maximum achieved focus value
(represented in the graph by a red line). In order to focus the specimen precisely proceed
as follows:

1. Select the Focus region tool and select the area you want to focus by dragging the
mouse in the live image. You can move the area by dragging the indicator.

2. While observing theFocus indicator, turn the focus adjustment knob of the microscope
slowly until the current focus value starts to decrease definitely.

3. Turn the focus adjustment knob of the microscope slowly into the opposite direction
to the rotation in step 2. This should increase the current focus value. Continue turning
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the focus adjustment knob until the current focus value restarts to decrease definitely.
Now, the value when the focus value was at maximum is retained and displayed as
the maximum value. This is the optimum focus value.

4. Turn the focus adjustment knob of the microscope slowly into the opposite direction
to the rotation in step 3. Continue adjustment until the current focus value becomes
identical (or as close as possible) to the maximum focus value. After the adjustment,
the specimen will be in the most accurate focus.

Focus region - reset: resets maximum and current value of the focus indicator.

Minimum sharpness: sets the minimum level of sharpness.

Standard sharpness: sets the normal level of sharpness.

Maximum sharpness: sets the maximum level of sharpness

Low contrast: reduces the level of image contrast.

Standard contrast: returns reduced or increased contrast level to the default value.

High contrast: increases the level of image contrast.

Linear contrast: sets the contrast to linear value.

White balance on defined region: by dragging the mouse in the live image you can
define the area for white balance.

Black balance on defined region: by dragging the mouse in the live image you can
define the area for black balance.
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Automatic white balance by pressing this button the white balance will be modified
according to the currently displayed image.

Automatic black balance: by pressing this button the black balance will be modified
according to the currently displayed image.

Show/hide automatic exposure region indicator: shows or hides the indicator of
auto exposure region. The auto exposure region will not change by hiding the
indicator.

Capture tab

This tab contains camera controls, that are used for modifying the camera parameters,
exposure and capturing images. These settings apply to the live image and captured images
as well.

Capture: captures the image and transfers it to the computer. You can also
use the [Ctrl + Enter] shortcut.

Full screen: the button is used for displaying the live image full screen. In
this mode, you can control the application using the Capture and Exit full
screen mode buttons in the upper part of the live image.

Size: Select the resolution in which the image will be taken. You can
choose from four qualities.

Binning: allows enabling the binning function. You can select from OFF, 2x2
and 4x4 modes. Binning is an electronic technique that combines the stored
charges of adjacent pixels on the CCD chip. The value in the field corresponds

to the size of the binning area. Binning increases the signal level by increasing the active
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area of each effective pixel which produces images with lower resolution. This is especially
useful for low light situations in which the signal level is low compared to the readout
noise. When the binning function is active the resolution of images is automatically lowered
which will reflect in the Size drop-down menu.

Accumulation: after you turn on the accumulation mode
and press Capture button the camera will capture
selected number of partial images. From these images

one image will be created and transferred to the computer. You can select Integral or
Average mode or turn the function off. Integral mode creates the resulting image by
summing the partial images. This mode is suitable for work with fluorescent samples to
increase the contrast between the background and the captured objects. Average mode
creates the resulting image by averaging the partial images. This mode is suitable for
reduction of the noise. Maximum number of partial images that can be captured is 64.

Exposure time: based on selected mode the
parameters of exposure can be set. When Auto
or SFL - auto mode is selected you can set the
exposure correction for darkening or brightening
the captured image. When the Manual mode is

selected you can modify the exposure time by clicking on the arrow or by dragging the
scroll bar. You can set the exposure time from 1/44000 to 60 seconds.

ISO sensitivity: When setting the sensitivity, you can choose from four levels
of capturing element sensitivity (200, 400, 800 and 1600). The levels conform
to the sensitivity of traditional photo materials in the ISO scale.

Exposure mode: when Manual mode is selected, the exposure time is
set by user. When Auto or SFL - auto mode is selected, exposure time
is set automatically according to the light conditions in the field of view.
SFL - auto mode is suitable for automatic exposure when inspecting

fluorescent samples. Furthermore, when using the Auto or SFL - auto mode, an
(Auto Exposure Lock) button, which “freezes” the exposure time at the current value, is
available.

Exposure region: A yellow rectangle, displayed in the live image, can
be used to set the exposure region. You can modify its size by setting
the percentage ratio to the live image size. In addition you can define
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your own size of the exposure region by pressing the Custom button and then define the
exact size and location by dragging the mouse in the live image. You can also move the
exposure region by dragging it or move it to the centre by pressing the Center button.

Live image tab

Live image quality: select the resolution for displaying the live
image from the camera. The setting is not reflected in the resolution
of the captured images.

Cross: check the option to display a cross in the live image. The
centre of the cross is placed in the centre of the field of view. The
centre cross is not part of the resulting image. The centre cross can
be used for measuring using the microscope stage.

Colour settings tab

You can use this tab to modify the colour balance of the captured image. The modifications
are visible in the live image immediately.

White and black balance: you can modify the colour balance of the live image to be as
close as possible to the reality. You can use the scrollbar to amplify or reduce level of
every colour channel (red, green, blue). By pressing the Region WB, Region BB buttons
you can select the region in the live image, that will be used for setting the colour balance
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of appropriate colour (black, white). By pressing the AutoWB, Auto BB buttons the balance
of appropriate colour will be set automatically.

Shading correction tab

This tab contains controls of the shading correction function. One can use this function to
eliminate image distortion caused by inhomogeneous illumination (darker corners) or dust
on the camera chip.

Shading correction: enables or disables the shading correction function.

Illumination: choose Reflected or Transmitted according to the type of
illumination. The way of shading correction differs for each type.

Calibration mask: after pressing the Capture mask
button a calibration mask will be captured. A
thumbnail of the mask will be displayed on the
panel next to the button.

Correction level: using this slider one can set how strong
the correction will be. After pressing the Preview in live
image button one can observe the shading correction
effect at the current setting and adjust the setting to
achieve the best result.
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Using the shading correction

To use the shading correction, it is necessary to capture a calibration image (mask). Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and, in case of need, adjust (shorten) the exposure time so you

can observe the inhomogeneity of illumination. The darkest areas shouldn't be black.
3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Illumination select

Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.

6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.

Reflected light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Don't focus the microscope and,

in case of need, adjust (shorten) the exposure time so you can observe the
inhomogeneity of illumination. The darkest areas shouldn't be black.

3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and selectEnable. In Illumination selectReflected.

Then press the Capture mask button. A thumbnail of the mask will be displayed on
the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.

6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.
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Important

The shading correction works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and further
images. After changing any setting it is necessary to capture a new calibration
mask.

Timestamp tab

The control panel is equipped with the function of insertion of the date and time of the
capture in the image - so called timestamp. The timestamp will become a solid part of the
image after the capture.

Timestamp: enables or disables the inserting of the timestamp into the
image.

Settings: press this button to open the Timestamp settings dialog.

Insert: choose which information should be inserted in the captured
images.

Orientation: this field shows the actual orientation of the timestamp text in
image. To change the orientation double-click into this field or press the
Settings button. The Timestamp settings dialog will open.
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Preview: this field shows the current
appearance of the timestamp reflecting all the
settings except the orientation. The text size is
the same as will be displayed in the image in
the zoom of 100% (1:1).

Position: the indicator shows the position
where the timestamp will be inserted to the
image.

Timestamp setting dialog

After the press of the Settings button or double-click to theOrientation field the Timestamp
settings dialog will open.

Format: in this part the appearance of the timestamp can be adjusted.

Position: here there can be selected the corner in which the timestamp should be placed.

Orientation: the orientation of the timestamp text can be selected to best fit the selected
position in the image.

164

Control Panels of Imaging Devices



Profiles tab

All the settings of the control panel (except the Shading correction) can be saved to one
of four available profiles and loaded easily at any time.

Save to profile: after the press of this button a dialog for saving of
actual control panel parameters will open.

Default profile: after the press of this button all the control panel
parameters will be set to the default values. The saved profiles will
remain unchanged.

Saving settings to a profile

In order to save the control panel settings to a profile proceed as follows:

1. Set the required control panel parameters.
2. Press the Save to profile button in the Profiles tab. The following dialog will appear:

165

Control Panels of Imaging Devices



3. From the Available profiles section select the profile you want to save current control
panel settings to.

4. Type a new profile name to Profile name field.
5. Confirm by pressing the OK button.

Loading of a profile

To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.
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6. OLYMPUS® DP20 Digital Camera

OLYMPUS® DP20 is a colour digital camera with a 1/1.8" CCD chip. The chip consists
of two million effective pixels. The highest frame rate at the highest resolution (1600x1200)
is 15 FPS.

OLYMPUS® DP20 camera control panel is intended to control the camera functions, live
image displaying and image capturing. It consists of a tool bar, four tabs and the live image.

Tool bar

Connect: the button is enabled only when the camera is not correctly connected.
Press the button to attempt to re-establish the communication.

Live image: turns on/off the live image.
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Cross: shows/hides the center cross.

Default: sets the default orientation of the live image.

Rotate 180°: rotates the image 180 degrees.

Mirror: mirrors the image along vertical axis.

Flip: flips the image along horizontal axis.

Grey scale: turns on/off the grey scale mode.

Normal: sets the edge enhancement to the normal mode.

Soft: sets the edge enhancement to the normal mode.

Off: turns the edge enhancement off.

Image tab

This tab contains camera controls, that are used for modifying the camera parameters,
exposure and capturing images.
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Capture: captures the image and transfers it to the computer. You can also use
the [Ctrl + Enter] shortcut.

OTWB: one touch white balance - click the button to automatically set the image
colours most naturally. This balance is suitable mainly when the camera senses
a white area.

Quality: select the resolution of the captured images.
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Exposure mode: if set to Manual, the exposure time value is set by the
user. If set to Auto, the exposure time is automatically set depending on
the illumination of the field of view. Furthermore, when using the

automatic mode, an (Auto Exposure Lock) button is available. It
“freezes” the exposure time at the current value while taking the images.

Exposure correction: this option allows you to brighten or darken the image
when the automatic exposure is set.

Exposure time: click the arrow or drag the slider
to set the exposure time. The value can be also set
using the [+] and [-] keys on the numeric keypad
or the [Page Up] and [Page Down] keys.

Colour temperature: used to set white balance for different kinds of
illumination.

Sensitivity: when setting the sensitivity, you can choose from three levels of
capturing element sensitivity (100, 200, 400). The levels conform to the
sensitivity of traditional photo materials in the ISO scale.

Live image on external monitor: here, one can turn on
displaying the live image on an external monitor and set its
resolution.

Focus region: this tool helps to focus the microscope. Proceed as follows:

1. Roughly focus the specimen using the focus knob. Press the Custom button. Draw a
frame into the live image by dragging the mouse with left button pressed. In case of
need, reshape or move the frame to the desired location.
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2. There will appear a blue bar indicator of current focus with a red line denoting
maximum achieved sharpness value next to the frame. At the beginning, the current
focus value and the maximum value are the same. These values will also be displayed
as numbers in the frame caption in the form of current value / maximum achieved
value.

3. When turning the focus knob now, the blue bar will raise or decline respectively
according to increasing or decreasing focus value. Choose the direction in which the
bar raises. Continue to turn the knob until the bar stops rising. The red line will remain
fixed at the position of maximum focus. Gently turn the knob in opposite direction
to make the bar touching the red line - the focus value is maximum in this position.
The numbers in the frame caption can be used in the same way.

Note

The focus value is measured relatively. It means, that the bar shows if current
focus increases or decreases against the starting value which is evaluated after
placing the frame. If focus exceeds scale of the bar, the bar is reinitialized to
approximately 3/4 of its scale. This doesn't mean that focus decreased rapidly. If
you continue turning the knob in the same direction and the bar starts raising
again, the focus is still increasing.

The measurement can be reinitialized by pressing the Reset button - the maximum focus
value will be set to the current value.

By using the Show / hide button, the frame can be hidden or shown again.

Note

After moving the focus region, the measurement will be reinitialized (see the
Reset button).

Shading correction tab

This tab contains controls of the shading correction function. One can use this function to
eliminate image distortion caused by inhomogeneous lighting (darker corners) or dust on
the chip.
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Shading correction: enables or disables the shading correction.

Light type: choose Reflected or Transmitted according to the type of
illumination. The way of shading correction differs for each type.

Calibration mask: after pressing the Capture mask button a
calibration mask will be captured. A thumbnail of the mask
will be displayed on the panel above the button.
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Correction level: using this slider one can set how strong
the correction will be. After pressing the Preview in live
image button one can observe the shading correction
effect at the current setting and adjust the setting to
achieve the best result.

Using the shading correction

To use the shading correction, it is necessary to capture a calibration image (mask). Proceed
as follows:

Transmitted light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Remove the specimen and, in case of need, adjust (shorten) the exposure time so you

can observe inhomogeneity of illumination. The darkest areas shouldn't be black.
3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Light type select

Transmitted. Then press the Capture mask button. A thumbnail of the mask will be
displayed on the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.

6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.

Reflected light

1. Focus the specimen, switch the exposure mode to manual and set the exposure time.
2. Insert a sheet of white paper under the microscope. Don't focus the microscope and,

in case of need, adjust (shorten) the exposure time so you can observe inhomogeneity
of illumination. The darkest areas shouldn't be black.

3. Press the Auto WB button (auto white balance).
4. Switch to the Shading correction tab and select Enable. In Light type select Reflected.

Then press the Capture mask button. A thumbnail of the mask will be displayed on
the control panel.

5. Insert the specimen and set the exposure time. You can use [+] and [-] buttons on the
numeric keyboard.
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6. Press the Preview in the live image button in the Correction level part and adjust the
correction level by using the slider in case of need. The shading correction will apply
to all further captured images.

Important

The shading correction works well only when all settings (illumination,
magnification, resolution) remain the same when capturing the mask and further
images. After changing any setting it is necessary to capture a new calibration
mask.

Timestamp tab

The control panel is equipped with the function of insertion of the date and time of the
capture in the image - so called timestamp. The timestamp will become a solid part of the
image after the capture.

Timestamp: enables or disables the inserting of the timestamp into the
image.

Settings: press this button to open the Timestamp settings dialog.
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Insert: choose which information should be inserted in the captured
images.

Orientation: this field shows the actual orientation of the timestamp text in
image. To change the orientation double-click into this field or press the
Settings button. The Timestamp settings dialog will open.

Timestamp setting dialog

After the press of the Settings button or double-click to theOrientation field the Timestamp
settings dialog will open.

Format: in this part the appearance of the timestamp can be adjusted.

Position: here there can be selected the corner in which the timestamp should be placed.

Orientation: the orientation of the timestamp text can be selected to best fit the selected
position in the image.
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Preview: this field shows the current
appearance of the timestamp reflecting all the
settings except the orientation. The text size is
the same as will be displayed in the image in
the zoom of 100% (1:1).

Position: the indicator shows the position
where the timestamp will be inserted to the
image.

Profiles tab

All the settings of the control panel (except the Shading correction) can be saved to one
of four available profiles and loaded easily at any time.

Save to profile: after the press of this button a dialog for saving of
actual control panel parameters will open.

Default profile: after the press of this button all the control panel
parameters will be set to the default values. The saved profiles will
remain unchanged.

Saving settings to a profile

In order to save the control panel settings to a profile proceed as follows:

1. Set the required control panel parameters.
2. Press the Save to profile button in the Profiles tab. The following dialog will appear:
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3. From the Available profiles section select the profile you want to save current control
panel settings to.

4. Type a new profile name to Profile name field.
5. Confirm by pressing the OK button.

Loading of a profile

To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.
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7. OLYMPUS® Consumer Digital Cameras (SP
and CAMEDIA® series)

The control panel of OLYMPUS® digital camera is used for displaying a live image,
controlling the camera functions and capturing images from OLYMPUS® SP and
CAMEDIA series cameras. The controls are located in two tabs.

Camera Control tab

The tab contains the controls for setting the camera parameters, setting the exposure and
capturing images.
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Capture: takes an image and transfers it to the computer. You can also use
the [Ctrl + Enter] shortcut or an external trigger if you have it.

Full screen: the button is used for displaying the live image full screen. In
this mode, you can control the application using the Capture, Refresh live
image and Exit full screenmode buttons in the upper part of the live image.

Quality: you can select from five quality levels (Super High Quality, High
Quality and Standard Quality 1 and 2 and TIFF). The SHQ and HQ modes take
images with full camera resolution in JPEG format with a different compression
ratio. SQ1 and SQ2 modes take images with lower camera resolution in JPEG
format. TIFF mode takes images with full camera resolution in TIFF format.
When using OLYMPUS® SP-350 and SP-500UZ the TIFF function is not
available

Sensitivity (ISO speed): when setting the sensitivity, you can choose from three
levels of capturing element sensitivity (100, 200 and 400). The levels conform
to the sensitivity of traditional photo materials in the ISO scale. When Auto is
selected, the camera changes the sensitivity automatically depending on the
prevailing lighting conditions.
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White balance: this option is used for setting the white colour balance
for various kinds of illumination. You can choose between Daylight,
Fluorescent light and Tungsten, Cloudy, Fluorescent (from 3500K
to 6700K), Shade, Sunset or automatic setting. The selected white
balance will immediately be reflected in the colour balance of the live
image. In this way, you can interactively adjust white balance.

Flash mode: you can choose from four flash modes: Automatic, Fill-in,
Off and Red eye reduction flash. If you are taking the images from a
microscope turn the flash off.

Focus mode: this mode offers three options: Auto, Manual and
Macro mode. If you select the manual focusing mode, you can
manually focus by sliding the slider on the right-hand side of
the control panel.

Warning

Turning the automatic focusing off is necessary to obtain the correct measurement
results. To achieve this select the Manual focus mode and move the Focus slider
to infinity.

Metering system: here, you can select one of two automatic exposure
metering systems – Digital ESP and Spot. The Manual option allows
you to set your own exposure parameters using the Shutter speed slider
andAperture from the drop-down menu. If you select the Shutter priority
option, set the Shutter speed slider and the corresponding aperture will

be set automatically. If you select Aperture priority, set the Aperture required and the
corresponding exposure time will be set automatically.
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Exposure compensation: this option allows you to brighten or darken
the image when the automatic exposure is set. Available are the values
from +2 to -2 in 1/3 steps.

Zoom: the zoom slider is used for controlling the focal length of the camera.
When using some types of digital cameras, stops will be indicated in the
right-hand range of the Zoom slider. They represent the value to which the

slider needs to be set while imaging from the microscope. For other cameras, set Zoom to
maximum value.

Warning

Obtaining the correct measurement results requires constant Zoom setting value
to be retained.

Shutter speed and Aperture: these options allow manual setting of exposure parameters if
Manual, Speed priority or Aperture priority is selected in Metering system menu.

Live Image tab

This tab contains the controls intended for setting the live image. The parameters are:
brightness, contrast, saturation, hue, borders. These settings do not influence the resulting
image.

Using the sliders, you can set the properties of the live image. The recommended procedure
is:

1. Capture the image and display it in View window.
2. Open the control panel of the OLYMPUS® digital camera and click the Live image

tab. Move the control panel to see the live image and the captured image at once.
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3. Using the sliders, set the live image parameters so that it is as similar as possible to
the captured image.

Borders slider can be used for setting the optimal size of the Live image. Set the slider so
that the live image fills the whole window of the control panel and black edges are
eliminated.

Press Default values to restore the default settings in the Live image tab.

Profiles

Profiles are used for quick and easy settings of camera functions. Each profile may contain
settings for all functions in the Camera control tab. The Standard, Microscope and Macro
profiles are set to default values and may be redefined at any time. The Custom profile is
used for saving a user profile.

Standard: preset profile for standard digital photography (e.g. using tripod).
SHQ resolution is set as well as automatic sensitivity mode, white balance, flash
and focus, ESP exposure measurement and zero exposure compensation.
Microscope: the parameters of a digital camera will be set for capturing images
from the microscope: maximum zoom, flash switched off, manual focus mode,
focused to infinity. The other parameters are identical to Standard profile.
Macro: the profile for macro imaging. The camera will be set to macro focus
mode with spot exposure metering.
Custom: the profile intended for creating your personal settings. Before the user
enters settings, the parameters are identical to Standard profile.
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Note

Upon activation of one of the profiles, a test image will be automatically captured
to set the camera correctly. It is then deleted immediately.

Other functions

Connect: button for connecting the camera. This function is used for repeatedly
connecting the camera after disconnection, e.g. in the event of switching it off.
Live image: used for switching the live image on the PC screen on and off.

Refresh: used for refreshing the live image (e.g. in case of excessive
illumination).
Erase: erases the camera's memory card contents.

Settings: opens a window with the options for redefining and restoring the
profiles and manual setting of the device for displaying the live image.

Creating a custom profile – editing the existing profile

1. To create a custom profile, first set the required camera parameters in the lower part
of the control panel in the Camera control tab.
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2.
Then press button. A dialog for setting
the profiles appears. Click the profile button
where you want to save the current parameters
of the camera. The selected profile will be
overwritten. If you want to restore the original
settings of Standard, Microscope and Macro
profiles, press Restore button.

Manual setting of the device for
displaying the live image

Upon first launch, the setting is made via the
Configuration wizard. The basic settings can be
edited using the Edit → Settings on the OLYMPUS
cameras tab.

You can manually change the settings from the Control panel of the OLYMPUS digital

camera by pressing button. In opened Settings dialog in Live image part click
Settings. A dialog for manual live image device configuration will open and several options
will be available. For manual setting, mark the relevant option and click Show dialog. This
procedure is intended for experienced users.
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8. Analog Video Source

The control panel allows capturing of images from analog video sources. The images can
be captured e.g. from analog cameras, video-endoscopic systems, ultrasonographs, VCR
or DVD.

Capturing tab

Capture: takes an image (according to the brightness, hue, contrast and
saturation settings) from an analog device and transfers it to the computer.

Full screen: the button is used for displaying the live image full screen.
In this mode, you can control the application using the Capture and Exit
full screen mode buttons in the bottom part of the live image.
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Image settings tab

Adjust: Brightness, Contrast, Hue and Saturation sliders can be used for setting respective
parameters. They apply to both the live image and captured images. Press the Default
button to restore the default values of all sliders.

Using controls in the Crop borders part there can be set the optimal size of the live image.
This way e.g. the unwanted black borders can be cropped from the image.

Displayed area: this indicator shows actual dimensions of live image (and
snapshots) in pixels.

Select: press this button to show a dialog for interactive selection of borders
to crop.

Reset: press this button to show whole image - crop function will be cancelled.

Restart live image: use this button in case there appear some problems with
display of a live image, for example, after returning from the screen saver
mode.

Setting up the borders to crop

After pressing the Select button there will appear a window with static image in which you
can select interactively the borders to be cropped. Select the area of the image you want
to keep displaying by the green rectangle. The rest will be cropped. Borders can also be
defined manually by the fields at the bottom of the window. Confirm by the OK button.
The settings will apply to the live image.
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Device settings tab

Input: select the input type of the analog signal depending on the connector
of currently used imaging device. You can select S-Video and Composite
(see figure). The S-Video input generally allows display of a higher quality
video signal then the Composite one.
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Timestamp tab

The control panel is equipped with the function of insertion of the date and time of the
capture in the image - so called timestamp. The timestamp will become a solid part of the
image after the capture.

Timestamp: enables or disables the inserting of the timestamp into the
image.

Settings: press this button to open the Timestamp settings dialog.

Insert: choose which information should be inserted in the captured
images.

Orientation: this field shows the actual orientation of the timestamp text in
image. To change the orientation double-click into this field or press the
Settings button. The Timestamp settings dialog will open.

Preview: this field shows the current
appearance of the timestamp reflecting all the
settings except the orientation. The text size is
the same as will be displayed in the image in
the zoom of 100% (1:1).

Position: the indicator shows the position
where the timestamp will be inserted to the
image.
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Timestamp setting dialog

After the press of the Settings button or double-click to the Orientation field the Timestamp
settings dialog will open.

Format: in this part the appearance of the timestamp can be adjusted.

Position: here there can be selected the corner in which the timestamp should be placed.

Orientation: the orientation of the timestamp text can be selected to best fit the selected
position in the image.

Profiles tab

Profiles can be used for quick setup of the control panel.
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Save to profile: after the press of this button a dialog for saving of
actual control panel parameters will open.

Default profile: after the press of this button all the control panel
parameters will be set to the default values. The saved profiles will
remain unchanged.

Saving settings to a profile

In order to save the control panel settings to a profile proceed as follows:

1. Set the required control panel parameters.
2. Press the Save to profile button in the Profiles tab. The following dialog will appear:

3. From the Available profiles section select the profile you want to save current control
panel settings to.

4. Type a new profile name to Profile name field.
5. Confirm by pressing the OK button.
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Loading of a profile
To load the desired profile press the corresponding button from Profiles section of Profiles
tab. The control panel parameters will be set automatically.
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Modules
1. Time Lapse Image Capturing (Timer)

QuickPHOTO Industrial 2.3 contains the Timermodule intended
for automatic image capturing in defined time interval. Activate

the module from Modules → Timer menu or click icon. The
module will automatically activate the control panel of the actual
imaging device.

The Timer can work in two modes:

• Number of images
• Time interval

Number of images capturing mode

In this mode you can select the number of images and the time
interval between image capturing. Set the interval in hours,
minutes and seconds. If you set the interval shorter than the time
required for transferring the image to the computer, the Time till
next capture value will change the colour to red. Then the next
image will be captured as soon as possible.

Start the capturing by pressing the button.
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Time interval capturing mode

In Time interval mode select the interval for capturing by
starting date and time and a day and time of the end.

Activate the capturing by pressing the button.

Note

TWAIN devices cannot be used for time lapse capturing.

Note

The value of the minimum interval between capturing images depends on the
type and settings of the imaging device used.

In the lower part of the Timer the Time till next capture, the number of Captured images
and the number of Remaining images will be displayed. The capturing process can be

aborted by pressing the button.

Saving images from time lapse capturing

In the lower part of the Timermodule in Save images part you can choose from two options:

1. in main window - thumbnails

The images will open in Thumbnail panel (in computer memory) and will not automatically
be saved to a disk. This option is limited by the memory size of your computer.

2. on disk in folder
(recommended option in case of large number of images)
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Prior to exposure, check the on disk in folder option and then click the icon next to the
option. In the dialog box that appears, select the folder for saving the images and press the
OK button. Enter the file name in the File name field. The five-digit number will be added
to the selected file name in order to sort the images properly. The default folder for saving
of images can be set via Edit → Settings → Default folders menu.

Note

The maximal number of images to be captured by the Timer module is 99999.

Note

For the long term time lapse image capturing it is recommended to turn off the
Windows® automatic updating function. If the Automatic updates are turned on
there is a risk of unwanted computer restart. It is also recommended to turn off
the screen saver and power saving mode.

2. Creation of Video Sequences (Time Lapse
Video)

The Time lapse video module delivered as a standard part of the application is designed
for creating video files from the captured time lapse images. E.g. if you capture several
images of a moving specimen, use the Time lapse videomodule to create a video file where
the movement will be recorded.

Procedure for creating the video sequence

1. Activate the Modules → Time lapse video function.
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2. Select the image source from which
the resulting video file should be
composed. You can choose from
three options:
• Process images selected in the
thumbnail panel – select this
option in case of fewer images
opened in the Thumbnail panel.
Only the images previously
selected in Thumbnail panel (blue
framed) will be processed. To
select images, hold the Shift or
Ctrl key down when selecting –
similarly to selecting several items
in Windows Explorer. The
selection needs to be made prior to activation the Time lapse video module.

• Select files to process (up to 2000 files) – select this option in case you have the
files (images) saved on disk. In the opened dialog, select all the files (images) from
which you want to make a video file. Maximal number of images to be rendered
this way is 2000, however the number can be much smaller. The actual maximal
number depends on the length of filenames.

• Select folder to process – select this option in case you have the files saved in a
folder. All images from the folder will be processed. This option allows the
processing of almost any number of images.

Press Next button to continue.
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3. In the next dialog, you can select
the properties of the video file to
be created. There are two options
available:
• Frame Interval - you can select

the time delay between the
images. This is useful e.g.
when you want to calculate
how many times the presented
situation has been speeded up
in comparison to reality.

• Frame rate - this option allows
you to create a video file of the
required duration or
smoothness. To create a
smooth video file, 25 images
per second are required at
least.

4. In Video resolution menu, you can select the quality of the resulting video file. The
higher the resolution, the greater the quality and file size.

5. In the Insert part there can be selected if the information about the date a time of
creation (so called "timestamp") of the images should be inserted into the video file.
The information will be taken from the properties of the image files. Select the desired
information to be inserted and click the Timestamp settings.
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In the opened dialog there can be
set the parameters of the
Timestamp. In Format section
choose the text settings. In
Position section choose location
of the timestamp in video file.
Confirm by pressing the OK
button.

6. Press Start button. A dialog
where you can select the location
and a name of the resulting video
file will pop up. Then press Save
button to start the video file
creation process.

The process status will be
displayed on the next page. In Rendering priority menu, there can be selected how
the CPU will be loaded by the process of video file creation. For parallel work e.g.
with QuickPHOTO programs we recommend to select Low option.

Press Pause button to
temporarily stop the process of
video creation, to resume press
Resume button. Press Back
button to terminate the creation
process and to modify the
settings. Press Close button to
cancel the process of video
creation.

The duration time of the process
depends mainly on the number
of selected images and the
performance of your computer.

7. A dialog box informing about the
successful completion of the
process will appear.
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3. Deep Focus (optional)
The Deep Focus module is a software module for QuickPHOTO programs which creates
images with depth of field much higher than is the depth of field of optical microscopes.
It can be used with stereo microscopes as well as with other types of optical microscopes
for observing in transmitted or reflected light.

The image with extremely high depth of field are composed from several "slices" - images
with different plane of focus. From each slice, only a well focused area is used. The
completely focused image is composed from the focused areas. Shift and scale change
between slices is compensated automatically.

The Deep Focus module is delivered as an additional module and can be used together
with QuickPHOTO CAMERA, MICRO and Industrial.

4. RECORD IT (optional)
RECORD IT is an additional module for QuickPHOTO programs, that enables recording
of digital video in a real-time from digital and analog cameras and other devices. With
RECORD IT module you can easily record the process of microscopic experiment, growth
of cell colony, endoscopic examination etc.

5. Fluo+ (optional)
The Fluo+ is an additional module intended for composing of multi-colour fluorescence
images. Up to 8 images captured with use of different fluorescence filters can be composed
to a single image. The intensity and x and y shift can be adjusted for each of the particular
images.
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Program Update
QuickPHOTO Industrial 2.3 can be updated either directly from Internet or a CD. The
Internet update is activated automatically (if you have enabled Auto-update from Internet
function) in case a new update file is available on the server. The Internet update can also
be performed manually from menu Help → Program update....

Activating the Internet update manually:

1. To activate the Update function run it from menu Help → Program update... and
select Update from the Internet option. Press Next button.

2. The program will search for available updates on the server. In case some updates
were found, their listing appears. Select the required updates and pres Next button.

3. You will be prompted to quit the program. Do so and press theOK button. The updated
files will download and install. Press Finish button to complete the update. Then the
updated program will be started automatically.

In case a connection cannot be established, you will be prompted to enter information
about your proxy server. The proxy server you use for browsing web pages may be detected
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from the settings of your WWW browser. If you do not know how to set the proxy server,
contact your network administrator. Check Use proxy server, enter the proxy server data
and press Next button.

Note

Before entering the information about proxy server we suggest pressing Previous
and then Next buttons. It is possible that the connection to the Internet server will
be successful. If this step is not successful it will be necessary to enter the
information about proxy server.

Important

If you use personal firewall program on your computer, permit the access to the
Internet for the Autoupdate.exe.
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Adding the Modules and Upgrading
to Higher Version

QuickPHOTO Industrial 2.3 can be upgraded to any higher version or plug-in modules
(RECORD IT, Deep Focus, Fluo+) can be added. The installation of each module or
upgrade is intended for one unique hardware key whose ID number is verified by the
installation wizard prior to the installation procedure. The first step in obtaining a new
module or an upgrade for your QuickPHOTO Industrial 2.3 installation is to send the ID
number of the hardware key to your software supplier (by e-mail or alternatively).

Procedure for sending the hardware key by e-mail:

1. In the Help menu select the option Send dongle number...
2. In the dialog box that pops up, you will see the ID of your hardware key and e-mail

address support@promicra.com.

If you are using an e-mail application (e.g. Microsoft® Outlook) press Send button. A new
e-mail containing the ID of your hardware key will automatically open. Fill your contact
information and name of the desired product and send the e-mail. Then you can order the
product from your software supplier.

If you do not use any e-mail application, create an e-mail message as usual (e.g. using your
Internet browser), copy the ID of your hardware key, fill your contact data and name of
the desired product and send it to support@promicra.com or your software supplier. For
more information about upgrading, see www.promicra.com.
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Troubleshooting and FAQ
QuickPHOTO Industrial 2.3 Program

How do I get the latest version of QuickPHOTO Industrial 2.3?

To obtain the latest version of QuickPHOTO Industrial 2.3 go to the
www.promicra.com/downloads.php page, select the desired product and follow the
instructions.

Which cameras are QuickPHOTO Industrial 2.3 program supported?

List of supported cameras in the latest version of QuickPHOTO Industrial 2.3 can be found
on www.promicra.com/cameras.php.

Are the Microsoft® Windows® 98 and Microsoft® Windows® ME operating systems
supported by QuickPHOTO Industrial 2.3?

No, they are not. QuickPHOTO Industrial 2.3 supports only Microsoft® Windows® Vista,
XP and 2000 operating systems.

“Unable to access config.xml” error pops up when closing QuickPHOTO Industrial 2.3.
What is wrong?

If you use MacAfee VirusScan, try to shut it down. If the problem disappears create an
exception for QuickPHOTO Industrial 2.3 in the MacAfee VirusScan program.

OLYMPUS® Consumer Digital Cameras
How can I switch OLYMPUS® digital camera to PC control mode?

Follow the instructions above, see “Switching the OLYMPUS® Consumer Digital Camera
to PC Control Mode“ on page 18.
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The OLYMPUS® digital camera does not react and it is not even possible to turn it off.
How can be the camera reactivated?

Before turning the camera off, it is necessary to close its control panel first. Then you can
turn off your camera and disconnect it. If you turn the camera off first or if you disconnect
the USB cable while the program is running, it may happen that the camera „freezes“. In
that case, disconnect the USB cable and the AC power adaptor (if used) and remove batteries
from the camera. Wait few seconds, insert the batteries back and turn the camera on again.
After performing these steps, the camera should operate correctly again.

The OLYMPUS® digital camera cannot be connected by the QuickPHOTO Industrial 2.3.
What should I do?

1. Check if the camera is switched on and connected to the computer via USB cable.
2. Check if the camera is switched to the PC CONTROL mode, see “Switching the

OLYMPUS® Consumer Digital Camera to PC Control Mode“ on page 18.
3. Check if memory card is inserted. (In case of OLYMPUS® SP and CAMEDIA® only.)
4. Make sure that the memory card cover is closed.
5. Check in the Device manager that the drivers of the camera are correctly installed as

shown on the following figures:

• OLYMPUS® E-System SLR camera:

• OLYMPUS® E-System E-330 SLR camera :

• OLYMPUS® SP and CAMEDIA® camera:
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If you can see the exclamation mark next to name of the device, uninstall the drivers,
turn the camera off and then on. The drivers should automatically be reinstalled.

The camera is not accessible as a Mass Storage disk unit. Is this a standard behaviour?

After switching the camera to the PC CONTROL mode, the camera is not accessible as a
Mass Storage unit. If you want to work with the camera like with another disk, you will
have to turn off the PC CONTROL mode, see “Switching the OLYMPUS® Consumer
Digital Camera to PC Control Mode“ on page 18. The optimal choice is to purchase a
USB memory card reader. You can avoid the necessity of switching the camera mode that
way.

OLYMPUS® E-330 Digital SLR Camera

Important

OLYMPUS® E-330 camera cannot be controlled from the Microsoft® Windows®

Vista and 7 operating systems. It is necessary to use administrator account for
using this camera in Microsoft® Windows® 2000 or XP operating systems.

It is not possible to control the OLYMPUS® E-330 camera via QuickPHOTO Industrial
2.3. How to fix the problem ?

1. Make sure that you use operating system Microsoft® Windows® 2000 or XP.
2. Make sure that you are logged in an user account with administrator privileges.
3. Make sure that the camera is connected to a computer via USB cable.
4. Make sure that the device for displaying a live image in QuickPHOTO Industrial 2.3

program is selected properly.
5. Make sure that selected imaging device is OLYMPUS E-system SLR digital camera.
6. Make sure that the camera is on and working in CONTROL mode.
7. Check if the battery is fully charged.
8. Make sure that the camera has the latest firmware (version 1.2 or later). The firmware

version can be checked in the camera menu Settings 2, the Firmware item. If the
firmware is older, upgrade it using OLYMPUS® MASTER 2 software supplied with
the camera.
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9. Run the Camera Setup wizard (...\Program Files\Common
Files\OLYMPUS\service\setupcam.exe) and follow on-screen instructions.

10. Turn the camera off, remove the battery, insert it back and turn the camera on again.

Live Image from OLYMPUS® Digital Cameras (all types)

I am not able to see the live image in the OLYMPUS® digital camera control panel. What
should I do?

1. Make sure the live image cable is connected to the camera and to the live image
displaying device. The CINCH connector from the camera should be inserted into
CINCH connector of the displaying device, see “Connecting the OLYMPUS®

Consumer Digital Camera to a Computer“ on page 21.
2. In Edit>Settings dialogue in section OLYMPUS® cameras make sure that Video

standard is set to PAL or PAL-B and input is set to composite. To restore the settings
of live images on this tab, you can use the Restore button.

3. Make sure there is Video Out set to PAL.

• OLYMPUS® E-System SLR cameras

Unplug all cables from the camera. Activate the menu of camera. In submenu
Settings 2, find choice VIDEO OUT and make sure it is an active choice PAL.

• OLYMPUS® SP and CAMEDIA® cameras

Unplug all cables from the camera with the exception of power. Activate the menu
of camera. In submenu Set, find choice VIDEO OUT and make sure it is an active
choice PAL. Next find the ALL RESET and set the option to OFF.

4. Make sure the DirectX 9.0c or higher is installed. You can find out the current version
of DirectX by typing "dxdiag" text into the run command from start menu. In the
bottom part of the following dialog you can see the current version of the DirectX.
You can find the DirectX 9.0c installation file on QuickPHOTO Industrial 2.3
installation CD, see “Installation of DirectX“ on page 11 or download it from Microsoft
web page.

5. Make sure there are not installed any codec packs like ffdshow, All In 1, K-lite Mega
Codec Pack etc. If any are present uninstall them.
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The live image from OLYMPUS® camera is not smooth or the live image quality is poor.

When using external USB 2.0 device AV USB 2.0 PRO for displaying the live image on
the monitor follow the next steps:

1. Make sure that the AV USB 2.0 PRO is attached to USB 2.0 port. If the computer does
not have USB 2.0 ports install the USB 2.0 PCI card or install internal grabbing card
Leadtek WinFast VC 100 XP.

2. Make sure that your computer complies with the minimal required computer
configuration. The minimal required configuration for AV USB 2.0 PRO is computer
with 1.4GHz processor and 256MB RAM. If your computer does not comply with
the minimal configuration you will have to use internal grabbing card LeadtekWinFast
VC 100 XP instead of AV USB 2.0 PRO or upgrade your computer.

The next step is common for AV USB 2.0 PRO and Leadtek WinFast VC 100 XP devices:

1. Disconnect all cables from the digital camera except the power supply.
2. Activate the menu of the camera. Check whether the setting VIDEO OUT in the sub

menu SET (or Settings 2 for OLYMPUS® E-System SLR cameras) is set to PAL. Next
go to the setting ALL RESET and select OFF.

I cannot see the live image in the OLYMPUS® E-System SLR camera control panel.

1. Make sure the live image cable is connected to the camera and to the live image
displaying device. The yellow CINCH connector from the camera should be inserted
into CINCH connector of the displaying device.

2. In case of using AV USB 2.0 PRO, make sure that the USB cable from the camera and
from device for displaying the live is not connected to the same USB controller.

Live Image from Analog Video Sources
I am not able to see the live image in the Analog Video Signal Sources control panel. What
should I do?
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1. Make sure the live image cable is connected to the camera and to the live image
displaying device. The yellow CINCH connector from the camera should be inserted
into CINCH connector of the displaying device. In case of video endoscopic system,
connect black S-Video connector from device for displaying the live image with
S-Video connector from video endoscopic system.

2. In Edit > Settings dialogue in section Analog video make sure that Video standard is
set to PAL or PAL-B and input is set to composite (In case of video endoscopic system
set S-Video input.). To restore the settings of live images on this tab, you can use the
Restore button.

3. Make sure the DirectX 9.0c or higher is installed. You can find out the current version
of DirectX by typing "dxdiag" text into the run command from start menu. In the
bottom part of the following dialog you can see the current version of the DirectX.
You can find the DirectX 9.0c installation file on QuickPHOTO Industrial 2.3
installation CD, see “Installation of DirectX“ on page 11 or download it from Microsoft
web page.

4. Make sure there are not installed any codec packs like ffdshow, All In 1, K-lite Mega
Codec Pack etc. If any are present uninstall them.

The live image from OLYMPUS® digital camera is not smooth or the live image quality
is poor. How to fix it?

When using external USB 2.0 device AV USB 2.0 PRO for displaying the live image on
the monitor follow the next steps:

1. Make sure that the AV USB 2.0 PRO is attached to USB 2.0 port. If the computer
does not have USB 2.0 ports install the USB 2.0 PCI card or install internal displaying
card Leadtek WinFast VC 100 XP.

2. Make sure your computer comply with the minimal required computer configuration.
The minimal required configuration for AV USB 2.0 PRO is computer with 1.4GHz
processor and 256MB RAM. If your computer does not comply with the minimal
configuration you will have to use internal displaying card Leadtek WinFast VC 100
XP instead of AV USB 2.0 PRO or upgrade your computer.

ARTRAY ARTCAM Digital Cameras

I am not able to install the camera drivers.
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Make sure that the camera is connected to the USB 2.0 port. We do not recommend
installing the camera into the front USB ports.

There is disconnecting of the camera when one starts the control panel.

When using the automatic exposure, make sure that preparation is sufficient lighting in
field of view camera.

IDS uEye® Digital Cameras

The camera is not listed in the Devices menu of QuickPHOTO Industrial 2.3 however the
drivers are installed and working correctly (the green LED diode on the camera is on - if
LED is present).

1. Support of this camera in QuickPHOTO Industrial 2.3 has probably not been installed.
Run installation of the QuickPHOTO Industrial 2.3 product from the installation CD.
On the page Select components of the installation wizard select uEye cameras. Finish
installation following on-screen instructions. All settings of the program will remain.

2. When using Microsoft® Windows® XP SP1 install Service Pack 2 or install USB
support patch number KB822603 from QuickPHOTO Industrial 2.3 installation CD
from uEye® patch folder or download it from www.microsoft.com.

I am not able to connect the uEye® camera from QuickPHOTO Industrial 2.3 program.

1. Make sure the camera is connected to the USB 2.0 port of your computer.
2. Make sure the LED on the camera is green and on (if LED is present). If the LED is

off or red it means that the drivers are not correctly installed and is necessary to
reinstall them. From QuickPHOTO Industrial 2.3 installation CD in directory drivers
> uEye® run uEye.exe and follow the installation instructions.

3. When using Microsoft® Windows® XP SP1 install Service Pack 2 or install USB
support patch number KB822603 from QuickPHOTO Industrial 2.3 installation CD
from uEye patch folder or download it from www.microsoft.com.

I cannot see the live image in the uEye® camera control panel.
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1. Make sure your computer comply with the minimal required computer configuration.
The minimal required configuration is computer with 1.4GHz processor and 512 MB
RAM.

2. Make sure your computer is not running any computationally intensive program. If
it is, shut it or wait for its completion.

3. In the control panel, go to Settings tab. Click the Settings button speed. It will adapt
the speed of uEye® camera (number of displayed frames per second) to the actual
performance of your computer.

QuickPHOTO Industrial 2.3 - Other

How can I find out that the computer is equipped with USB 2.0 ports?

You can use the checkusb.exe program developed by IDS (Imaging Development Systems
GmbH) to determine the version and number of USB the ports. The program is located on
QuickPHOTO Industrial 2.3 installation CD in CheckUSB folder. It can be run from
QuickPHOTO Industrial 2.3 autorun screen after inserting the CD into the CD-ROM drive.

I am not able to playback the video created by Time lapse video module on the other
computers.

The proper codec is probably not installed. Install the codec from installation CD from
Codec folder or download it for free from http://www.promicra.com/downloads.php from
Utilities section.

I did not found the answer to my question. Where can I get more information?

Try to find your question in Help of QuickPHOTO Industrial 2.3 program, or contact our
technical support department:

email: support@promicra.com

phone: +420 222 968 963 (Mo - Fr: 9 AM - 5 PM)
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Specifications
Minimum system requirements for OLYMPUS® digital cameras (for
Microsoft® Windows® XP/2000 operating system)

Note

The system requirements for Microsoft® Windows® Vista operating system may
be much higher.

Variant with internal PCI card for displaying a live image:

• Processor Intel or AMD 750 MHz
• 512 MB RAM
• CD-ROM drive
• 2x USB 1 or 2.0 port

Variant with external USB 2.0 device for displaying a live image:

• Processor Intel or AMD 1.4 GHz
• 512 MB RAM
• CD-ROM drive
• 1x USB 2.0 port
• 2x USB 1 or 2.0 port

Minimum system requirements for ARTRAY ARTCAM digital cameras (for
Microsoft® Windows® XP/2000 operating system)

Note

The system requirements for Microsoft® Windows® Vista operating system may
be much higher.

• Processor Intel or AMD 2.4 GHz (ARTCAM 300MI), processor Intel or AMD 3.0 GHz
(ARTCAM 500MI)

• 512 MB RAM
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• CD-ROM drive
• 1x USB 2.0 port
• 1x USB 1 or 2.0 port

Minimum system requirements for IDS uEye® digital cameras (for
Microsoft® Windows® XP/2000 operating system)

Note

The system requirements for Microsoft® Windows® Vista operating system may
be much higher.

• Processor Intel or AMD 1.4 GHz
• 512 MB RAM
• CD-ROM drive
• 1x USB 2.0 port
• 1x USB 1 or 2.0 port

Supported operating systems

• Microsoft® Windows® 7/Vista/XP/2000

Minimum screen resolution

• 1024 x 768
• 24 or 32 bit resolution

Supported imaging devices

A list of currently supported imaging devices is available on http://www.promicra.com.

OLYMPUS®, CAMEDIA® are registered trademarks of OLYMPUS Corp.

Microsoft®, Windows® are registered trademarks of Microsoft Corp.

uEye® is a registered trademark of IDS Imaging Development Systems Inc.

Lumenera® is a registered trademark Lumenera Corp.
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Unlock, 42

Camera
Captures in, 126

Camera control, 178
Capture, 52, 110, 123, 135, 150, 158, 169, 
179, 185
Capturing, 185
Change

Colour, 65
Position, 64
Size, 64
Thickness, 65

Codec, 25
Colour

Colour mode, 156
Gray scale mode, 156
Mode, 114, 126
Settings, 160
Temperature, 170

Colours, 113
Configuration

Initial configuration of the application,
31

Connect, 110, 123, 134, 150, 167, 183
Contrast, 114, 126, 140, 151

High, 157
Linear, 157
Low, 157
Standard, 157
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Control Panels, 109
Copy, 50
Creation of video sequences, 195
Cross, 126, 134, 151, 160, 168

D
Deep Focus, 199
Default

Folders, 33, 102
Orientation, 168
Profile, 121, 132, 165, 176, 190
Settings, 115, 127, 152
Values, 182, 186

Deleting a drawn object, 65
Device, 48

Input, 187
Select, 57
Settings, 187

Dongle, 25
Draw, 63

Arrow, 54, 63
Circle, 54, 63
Ellipse, 54, 63
Font, 54
Freehand, 54, 64
Line, 53, 63
Polygon, 54, 64
Rectangle, 54, 63
Text colour, 54

E
Edge enhancement, 127

Normal, 168
Off, 168
Soft, 168

Edit, 46

Clear all inserted objects, 46
Configuration wizard, 46
Copy, 46
Crop, 59
Flatten image, 46
Flipping the image, 60
Line width, 46
Mirroring the image, 60
Object colour, 46
Paste, 46
Redo, 46
Resizing the image, 61
Restore original image, 46
Settings, 46
Undo, 46

Erase, 183
Exposure

Compensation, 112, 181
Correction, 124, 170
Exposure correction, 136
Exposure mode, 136
Exposure region, 136
Exposure time, 136
Mode, 124, 150, 159, 170
Region, 124, 159
Time, 124, 151, 159, 170

F
FAQ, 205

ARTRAY ARTCAM Digital Cameras,
210
IDS uEye® Digital Cameras, 211
Live Image from Analog Video Sources,
209
Live Image from OLYMPUS® Digital
Cameras, 208
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OLYMPUS® Consumer Digital
Cameras, 205
OLYMPUS® E-330 SLR Camera, 207
Other, 212
QuickPHOTO Industrial 2.3 program,
205

File, 45
Close all, 45
Close selected, 45
Exit, 45
Open, 45
Open image, 59
Print, 45
Print setup, 45
Recent files, 45
Save, 45
Save all, 45
Save as, 45
Save measured values, 45

Flash
Bias compensation, 113
Mode, 113, 180

Fluo+, 199
Focus

Metering mode, 113
Mode, 180
Region, 125, 170
Reset indicator, 157

Focus region, 137
Frame rate, 127, 139
Full screen, 110, 123, 135, 150, 158, 179, 
185

G
Gain, 126, 140, 151
Gamma, 126, 141, 152
Gradation, 114

Gray scale, 168
Grid, 107

Circular, 74
Orthogonal, 74

grid, 73

H
Handling Object

Changing colour, 83
Changing the position, 83
Changing the size, 82
Delete, 83
Drawn, 64

Hardness, 78
Brinell, 78
Vickers, 80

Harness, 108
Help, 49

About, 49
Program update, 49
Send dongle number, 49
What's new, 49

Hue, 141, 151

I
IDS uEye® digital camera, 122
Illumination compensation, 141
Image, 46, 123, 149, 168

Crop, 50
Crop borders, 115, 186
Default orientation, 134
Displayed area, 115, 186
Editing, 59
Flip, 50, 134, 168
Flip horizontally, 156
Flip vertically, 156
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Grey scale, 134
Mirror, 50, 134
Quality, 110, 150, 169, 179
Reset borders, 115, 186
Resize, 50
Restart live image, 115, 186
Rotate, 156
Rotate 180, 134
Save, 65
Select borders, 115, 186
Size, 158

Image information, 49, 94
Image processing, 59
Image quality, 139
Image settings, 186

Default, 141
Image tab, 135
Input

Composite, 187
S-Video, 187

Insert
Horizontal scale bar, 51
Text, 54, 64
Vertical scale bar, 51

Installation, 9
Application, 25
ARTRAY ARTCAM digital camera, 22
AV USB 2.0 PRO, 15
Device for displaying a live image, 10
Dongle, 24–25
IDS uEye® digital camera, 22, 25
Language choice, 25
Leadtek WinFast VC100XP, 12
Lumenera® INFINITY, 24
OLYMPUS® digital camera, 17
OLYMPUS® DP20 digital camera, 23
OLYMPUS® DP72 digital camera, 23

OLYMPUS® E-System, 26
Video codec, 25

ISO sensitivity, 159

L
Language, 25, 103
Live image, 114, 160, 167, 181, 183

On external monitor, 170
Quality, 124, 151, 160

Live view, 139
Live view mode, 113
Live view resolution, 139
Live view size, 139
Lumenera® INFINITY, 133

M
Macro, 112
Magnification, 51
Main window, 43

Menu bar, 44
Navigator, 44
Status bar, 44
Table of measured values, 44
Thumbnail panel, 44
Tool Bar, 44
View window, 44

Manual black balance, 141
Manual white balance, 127, 141
Marking and labeling of interesting areas,
62
Measure

Angle, 52
Arbitrary distance, 51
Arc, 52
Brinell hardness, 54
Circle, 51
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Count objects, 51
Distance between parallel lines, 52
Ellipse, 51
Phase analysis, 52
Polygon, 51
polyline, 51
Rectangle, 51
Vickers hardness, 54

Measured quantities, 107
Measurements, 47, 68

Active calibration, 47
Angles, 73
Arc, 73
Calibration manager, 47
Calibred scale bar, 70
Circle, 71
Colours/Sizes, 105
Distance, 73
Ellipse, 71
Grid, 73, 107
Handling measuring objects, 82
Hardness, 78, 108
Length, 71
Line colour and thickness selection, 69
Magnification selection, 69
Measured quantities, 107
Measuring tools, 70
Phase analysis, 75
Polygon, 72
Polyline length, 72
Preparation for measurement, 69
Rectangle, 71
Scale bar settings, 70
Scale bars, 70, 104
Settings, 69
Table of measured values, 83
Units, 47, 104

Menu bar, 45
Metadata, 94
Metering mode, 111
Metering system, 180
Mirror, 168
Modification of text labels, 65
Modules, 48, 193

Time lapse video, 48, 53
Timer, 48, 53

N
Navigator, 43, 56

O
OLYMPUS®

Consumer Digital Cameras, 178
DP20, 167
DP72, 155
E-System, 109

Open, 49
Original size, 47

P
Paste, 50
Performance test, 139
Phase Analysis, 75
Presentation, 95
Print, 49, 67

Profiles, 68
Profile, 131, 146, 150, 165, 176

Create, 183
Custom, 182
Default, 121, 132, 147, 165, 176, 190
Load, 122, 132, 147–148, 166, 177, 191
Macro, 182
Microscope, 182
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Save, 121, 131–132, 147, 165, 176, 190
Standard, 182

Profiles, 182, 189
Program, 111

Update, 201

R
RECORD IT, 199
Redo, 50
Refresh, 183
Region

Black balance, 157
Hide, 158
Show, 158
White balance, 157

Reports, 48, 86
Create template, 48
Creating a sample for the template, 86
Creating reports, 91
Creating templates, 88
Template manager, 48, 91

Resolution, 111
Rotate, 168

Clockwise, 50
Counter-clockwise, 50

S
Saturation, 114, 141, 152
Save, 49
Scale bars, 104
Select, 53

Line colour, 63
Line thickness, 63

Selected area, 50
Sensitivity, 111, 170, 179
Sequence, 111

Settings, 96, 126, 151, 183
Analog video source, 32, 97
Automatic Update, 36
Configuration wizard, 31
Control panels, 98
Default Folders, 33, 102
External trigger, 37, 100
General, 96
Image numbering, 99
Imaging device, 31
Initial Measured Quantities, 35
Language, 103
Measurements, 104
OLYMPUS® cameras, 96
OLYMPUS® digital cameras, 31
Presentation mode, 102
Profiles, 120
Scale bar and units, 34
Twain device, 31
Update, 101

Settings tab, 140
Shading correction, 116, 127, 142, 152, 
161, 171

Activation, 117, 127, 142, 152, 161, 172
Calibration mask, 117, 128, 143, 153, 
161, 172
Correction level, 117, 128, 143, 153, 
161, 173
How to use, 143
Illumination, 117, 128, 142, 161
Light type, 152, 172
Preview, 143
Using, 117, 128, 153, 162, 173

Shading mode, 114
Sharpness, 114, 151

Maximum, 157
Minimum, 157
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Standard, 157
Show

Image information, 94
Shutter speed, 111
Snapshot size, 135
Specifications, 213
Speed adjustment, 123, 127
Status Bar, 56

T
Table of measured values, 47, 56

Hiding, 85
Image tab, 84
Inserting notes, 85
Releasing, 85
saving measured values, 84
Settings, 85

Thumbnail, 55
Thumbnail panel, 43
Time lapse image capturing, 193
Timer, 193
Timestamp, 118, 129, 144, 163, 174, 188

Activation, 119, 130, 145, 163, 174, 188
Format, 120, 146, 189
Insert, 119, 130, 145, 163, 175, 188
Options, 145
Orientation, 119–120, 130, 145–146, 
163, 175, 188–189
Position, 119–120, 130, 146, 164, 176, 
188–189
Preview, 119, 130, 146, 164, 176, 188
Settings, 119, 130, 163, 174, 188

Tool Bar, 49, 156, 167
Tool bar, 134
Troubleshooting, 205

U
Undo, 50
Units, 104
Upgrade, 203

V
View, 46

Circular grid, 52
Four images, 52
Full screen, 47
Image information, 46
Original size, 53
Orthogonal grid, 52
Presentation mode, 47
Show circular grid, 47
Show inserted objects, 46
Show measured values in image, 46
Show orthogonal grid, 47
Show table of measured values, 47
Single image, 52
Table of measured values, 52
Two images, 52
Window, 47, 50, 56
Zoom all, 47, 53
Zoom in, 53
Zoom out, 53

W
White balance, 112, 137, 152, 160, 169, 180

Auto, 158
Default, 141

Window, 49
Restore layout, 49
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Z
Zoom

in, 47
out, 47
Standard view, 156
Zoomed view, 156
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